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Overview 

PhoneValet Message Center is Parliant’s business-class product that 
provides detailed call logging, recording and voice mail features, including 
the ability to build sophisticated “trees” of options for people calling in. 

Inside your PhoneValet package is the Parliant Telephone Adapter, a 
USB cable for connecting it to your computer, a telephone cable, and a 
telephone line splitter (to plug in both the Telephone Adapter and a 
telephone into one wall socket).  Also included are a Quick-Start guide, 
and the software on a CD. 

Visit the Parliant’s web site if you need more help with PhoneValet.  Go to 
http://www.phonevalet.com/support/ for up-to-date technical support 
resources, and software updates. 

System Requirements 

PhoneValet requires at least this configuration: 

• Computer that meets Apple’s system requirements for MacOS X 
• Mac OS X 10.3.9 or higher installed 
• QuickTime 6.5.3 or higher installed 
• Available USB port 
• Regular (analog) phone line, with touch-tone service, near your 

computer. 
• Mac OS Finder-compatible CD burner or “SuperDrive” for disc 

archiving 

PhoneValet is delivered as a Universal Binary, so it runs at full 
performance on both PowerPC Macs, as well as all new Intel processor 
Macs. 

Inbound call announcement/ringtones, call blocking, and inbound call 
logging features require Caller ID service from your local telephone 
provider.  Call Transfer service is required on your line for the voice mail 
transfer feature.  A modem is not required to use PhoneValet – all the 
software and hardware you need is included in the PhoneValet package.  

If you want to receive faxes with our voice mail/fax integration, then you 
will need a shared-line fax machine, or a compatible modem to receive 
faxes with (such as Apple’s internal or USB modems) along with fax 
software such as PageSender or the Mac OS built-in faxing support. 

Installation 

Installing PhoneValet 

First thing to do is to plug in the Telephone Adapter device – all the 
cables are included, so all you need to do is connect the USB cable to our 
device and to a port on your Mac, and use the phone cable to connect the 
device to any telephone wall-jack.  If you have a telephone already 
plugged in to the wall, plug the splitter (included) into the wall and connect 
both our device and the telephone to it. 

If you have purchased any additional Telephone Adapters (to allow 
multiple phone lines to be used with PhoneValet), please connect all 
those devices as well.  If you are using a USB hub, make sure that it has 
its own power supply – see page 37 for details. 

PhoneValet software installation is also simple – simply insert the product 
CD, review the “Read Me” file for last-minute updates, and then double-
click on the PhoneValet Installer icon.  Follow the on-screen instructions 
to complete the installation of PhoneValet.  You will need to restart the 
computer after installation. 

If you are currently using the OpenBase database software on your 
computer, you may be prompted to upgrade it.  Please see page 37 for 
information about the OpenBase database that is included with 
PhoneValet. 

Running PhoneValet for the First Time 

Once you have successfully installed the PhoneValet hardware and 
software, it’s time to run the program!  To run it, simply click on the 

http://www.phonevalet.com/support/


PhoneValet Application Alias icon on your desktop, or use the Finder to 
navigate to the Applications folder, and click on PhoneValet. 

The first time you run PhoneValet, you will need to enter your license 
code(s) for the software, which you will find on a license card in the box. 
On the license screen that comes up, simply click on a line, and click the 
Edit… button.  Enter your license code on the panel, and edit the line 
name if you want.  The line name is shown on all calls in the call log, and 
will be read to you when a call comes in if you have more than one 
telephone line. 

If you have ordered PhoneValet Anywhere, first enter your PhoneValet 
line licenses as above, and then click on the Add… button on the bottom 
right of the panel to enter the option license(s).  Option licenses are 
usually delivered by email. (See page 39 for Anywhere installation help) 

Click on Next after entering your license(s).  You are now asked to enter 
your local area code, and whether you want to use Voice Mail, Voice 
Dialing and Call Announcements.  The area code is used to tell whether a 
call is local or long distance when you are dialing.  If you live in a ten-digit 
dialing area, you can set up more area codes in the preferences later. 

The PhoneValet product includes two views of your calls.  The main view 
gives you access to PhoneValet’s phonebook and integration with Apple’s 
Address Book, and your whole call history including all voice mails, call 
recordings and call details. 

The second view – the New Calls window – is provided to give you 
convenient access to your recent incoming calls and voice mail 
messages, so you can focus on the calls you may need to respond to.  It 
acts like a typical answering machine and/or Caller ID box does, showing 
you what calls you’ve had recently, and your recent messages.  We’ll see 
more about this way of viewing calls in the Voice Mail section.  You can 
display this window by clicking the New Calls button in the toolbar, or by 
clicking on the Window menu. 

 
Main Call Log Window 

 

 
New Calls Window 
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PhoneValet Anywhere is an add-on option to PhoneValet that allows 
access to the phonebook, call log and call recording controls using a web 
browser, and also provides Caller ID announcements to other computers 
(Windows PCs and Macs) on your network. 

Multiple Line Configurations 

If you have more than one telephone line in your home or office, you can 
connect more than one Telephone Adapter to your computer (one for 
each line) so that you can use PhoneValet’s features on all your lines.  
The PhoneValet product is sold by-line, and you can obtain additional 
lines from your local Mac retailer or the Parliant web site at 
http://www.parliant.com/store. 

If you have purchased multiple Telephone Adapters, connect all of them 
before doing the software installation.  When you are asked to enter 
licenses to use PhoneValet, you will enter one code per Adapter.  If you 
are adding a new adapter to an existing installation of PhoneValet, simply 
connect it to the computer and phone line, and then go into the 
PhoneValet General Preferences, click on the Lines tab and enter your 
licenses.  If your new device does not show up in the preferences screen, 
click the Refresh List button; PhoneValet will then show your new 
Telephone Adapter. 

Getting to Know PhoneValet 

PhoneValet has many useful features that we will cover … 

• Using the voice mail system 
• Using the phonebook 
• Dialing by voice or mouse-click 
• Using the call log to track your calls in and out 
• Recording your calls 
• Having PhoneValet announce your incoming calls 
• Importing and export information 
• Using Call Actions to run AppleScripts 
• Remote-Controlling your computer by calling in 

Voice Mail 

The voice mail feature lets your Macintosh act as an advanced answering 
system.  When active, the voice mail system will answer all calls after a 
set number of rings, play the caller a greeting you provide, and let the 
caller leave a message.  With additional Telephone Adapters, this voice 
mail can extend to multiple phone lines with ease. 

If you choose, you can create an essentially unlimited set of choices for 
callers to select from, including the ability to create a “tree” of options 
where people can choose from a menu of choices.  The choices can be 
mailboxes to leave messages, announcement-only choices for 
information services, call-transfer choices or remote control script options. 
There is also a “page and pause” type that acts like an automated 
attendant – it puts the caller on hold and announces who the call is for on 
the computer(s). You can build a multi-level call tree by creating menus 
within menus – as deep as you need. 

The caller will dial one or more numbers on their phone to pick a choice.  
Each choice can play another greeting/message to the caller and then the 
choice’s action is taken (another menu, beep and take a message, etc...) 

You can set custom greetings and other custom voice mail handling for 
particular callers.  See page 15 for details on how to do this. 

Voice Mail Workflow 

If you have only the Main mailbox enabled, PhoneValet acts like a normal 
household answering machine -- it will play the main greeting, beep, and 
then take a message. 

If you change the main box into a menu and make choices under that 
menu, then PhoneValet will answer the call as above, but after playing the 
main greeting it will pause for a few seconds to let people make a choice 
by pressing the appropriate number(s) on their phone.  The caller can 
make their choice during the greeting, or during the pause. 

http://www.parliant.com/store


If the caller doesn't make a choice, PhoneValet can be configured to 
repeat the greeting, or to assume a particular choice (such as a catch-all 
mailbox that you choose).  If the caller does dial a choice, then 
PhoneValet will act on that choice – playing a given greeting or another 
menu, transferring the call, etc… 

At any time during a menu/greeting, the caller can press the pound (#) 
button on their phone - if they do, the greeting will stop, and PhoneValet 
will jump to that choice’s action.  This lets people who know your setup 
avoid listening to the whole greeting.  During the main greeting, you can 
also press the (*) button to enter remote-control mode or to call in to 
check messages – see the section on Remote Control on page 20 below. 

Configuring Voice Mail 

To configure the voice mail system, click on the PhoneValet menu, and 
select Preferences → Voice Mail…  On this screen, you can enable the 
voice mail feature, build your call tree(s), and set basic voice mail 
preferences.  You can also create overrides, which let you customize 
voice mail based on day/time or which line calls are on. 

First, make sure the Voice Mail Enabled checkbox is checked at the 
bottom-center of the window.  Then, click on Settings on the left side, 
where you can select the number of rings to answer and set what the 
maximum length of message you want is (PhoneValet will hang up on the 
caller after that long, if the caller doesn’t hang up).  You can also set your 
access code to call in for messages; the code gives you access to all 
messages.  You can give out codes to access individual mailboxes on the 
mailbox-editing screen. 

To start, PhoneValet provides a single mailbox called Main that plays a 
generic message and then takes a message.  To change the greeting that 
plays when the voice mail first answers a call, click on the Main item at 
the very top of the left side.  On the right side, click the Play button to hear 
the current greeting.  To change the greeting, click the Change… button.  
See page 8 for details on setting greetings. 

If you want to provide choices to your callers, change the Type of the 
Main item to Menu, and then you will be able to add choices under it.  To 
add choices, click on the Actions menu at the bottom-left. 

When adding choices, you can set the digit(s) that the caller must enter – 
when you click on a choice on the left side, a box appears that lets you 
type the digits.  On the right half of the window are the settings for the 
selected choice – you can change the name, greeting and rules for what 
happens at the end of the choice.  You will see details of each choice type 
below. 

About Call Trees and Overrides 

When PhoneValet answers a call, it starts the caller at the Main tree.  
When you make Main into a menu, it becomes the top of a call tree, and it 
is the default tree used when PhoneValet answers calls.  A tree lets you 
create one or more levels of menus, where each menu contains a set of 
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choices for the caller to pick from.  A menu can have many choices, and 
you can put menus under other menus to create as many levels in your 
tree as you need. 

You can add other call trees to PhoneValet by clicking on the Actions 
pop-up menu.  You would create other trees so that you could set up your 
voice mail to behave differently based on day and time (such as at night, 
on weekends, etc…), or so that you could have different voice mail 
configurations on different phone lines (for instance, separate menus for a 
home-line and business-line in a home-based office).  You may also 
create trees to save voice mail configurations for special times of the 
year, such as an altered setup for holidays. 

When you make a new tree, it is not immediately used by PhoneValet.  To 
cause PhoneValet to answer some calls using an alternate tree, you 
create an Override which describes when to use a particular tree instead 
of the default tree.  You can also send specific callers to a given tree 
using Caller ID – see Profiles on page 15 for more information. 

To create an override, click on the Actions menu again, and select New 
Override.  You can edit the override on the right side of the window – set 
a name for the override.  Select the tree you want to answer with, and the 
rule for answering – either based on selected times/days, on selected 
lines, or a combination of both options.  If desired, you can change the 
number of rings at which PhoneValet will answer – for instance to make it 
answer quickly at lunchtime or at night when no-one will be in the office. 

Overrides can also be used to disable voice mail on certain lines, if you 
don’t want PhoneValet to answer all your lines – simply make an override 
set to “Do not answer” and pick one or more lines to disable from the list.  
You can disable lines at certain times of day as well, if you are sure that 
people will be available to answer calls. 

Menu Choices 

A menu lets you play a prompt to the caller which describes the options 
available to them, and then they can pick which option they want.  You 

can also decide what happens if the caller doesn’t make a choice – you 
can drop them into a given sub-choice by clicking Assume selection and 
selecting any of the choices under this menu.  You can opt to repeat the 
greeting up to 5 times (hanging up if the caller still doesn’t pick), or you 
can send the caller to another place in your call tree using the Go to 
option. 

“Take a Message” Mailbox Choices 

All messages are stored in mailboxes.  You can make a mailbox for each 
person in an office or home, or to assign mailboxes by department for a 
business. 

You can select whether or not you want a mailbox prompt played.  This 
prompt will be played to the caller after they’ve selected the mailbox, and 
then PhoneValet will beep to indicate the caller can leave a message.  
Click the Change… button to set your greeting.  If you don’t want a 
greeting, that’s OK – PhoneValet will just beep and start recording. 

You can set the mailbox to send an email (including the message as a 
sound file attachment) by checking that option on, and entering one or 
more email addresses.  The email will be sent after the caller hangs up 
from leaving a message.  See page 28 for help on email settings.  If you 
are emailing to an Apple iPhone, make sure to upgrade to iPhone 
software 1.1.1 or higher in order to play audio file attachments. 

If you want people to be able to call in and check for messages for a 
mailbox, check the box, and enter the desired access code.  This code 
will allow the caller to access only the given mailbox’s messages. 

Announcement Choices 

Announcement choices let you build an information system into your 
voicemail.  By setting one or more choices as Announcements, you can 
deliver messages to your callers such as business hours messages, 
event/theatre/club listings, etc... 

You click the Change… button to set the message to play to the caller. 
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After the message finishes playing to the caller, you can opt to hang up 
on the caller after the announcement is played, replay the message up to 
5 times before hanging up, or return the caller to the menu they were on.  
You can also send the caller to the place where voice mail started (the 
main greeting and menu), or send them to another place in the call tree 
by selecting the Go to option. 

Transfer Choices 

The transfer feature within voicemail allows the caller to be transferred to 
a different number upon making a choice from the main menu. This can 
be used to transfer a caller to a particular extension within an office 
environment, or to transfer a call to an outside number (e.g. your cell 
phone) on a regular line. 

In order to use this feature you must connect your Parliant Telephone 
Adapter to an office telephone switch, or have a telephone line which 
supports Centrex (business phone) service or is subscribed to Call 
Transfer from your telephone provider. 

Most telephone systems allow for a transfer by “flashing” the line (hanging 
up briefly, then picking up again), then dialing the number of the line to be 
transferred to, and then hanging up again. This method of transferring is 
often referred to as “Centrex Transfer”. This is the mechanism used by 
PhoneValet to transfer the call. 

You may wish to set a prompt to tell the caller that they should wait to be 
transferred.  Enter the phone or extension number exactly as PhoneValet 
should dial it. PhoneValet will flash the line before dialing these digits. In 
an office environment do not forget to add a 9 (or appropriate outside-line 
access code) if you wish to transfer the call onto the regular telephone 
network. 

NOTE: PhoneValet's call transfers are “unsupervised”. This means that 
PhoneValet does not monitor the call once the transfer is initiated. In the 
event that a transferred call is not completed (due to no-answer or busy) 
the call will be handled appropriately by the telephone line provider's 

equipment (the caller may hear a busy tone, or go into the voicemail 
provided on the number they are being transferred to). If a call cannot be 
completed in an office environment, your telephone switch may ring back 
to the Parliant Telephone Adapter that initiated the transfer in which case 
the caller will hear the main menu again. Once the call is transferred, 
PhoneValet no longer controls the call and it will be logged as finished. If 
equipment causes the call to ring back to PhoneValet it will be treated as 
a new call. 

Remote Control Choices 

A final choice available for callers is a remote control choice.  Remote 
Control is a special feature of PhoneValet that allows callers to call in and 
run scripts using a special mode.  The feature is described in detail on 
page 20.  If you have set up remote control scripts, you can now make 
selected scripts available as choices from the main voice mail menu, so 
that your callers do not have to enter the special remote control mode. 

To use this feature, first configure your remote control scripts using the 
regular remote control system.  Once you have scripts working, you may 
create choices in the voice mail preferences to run a script.  To do this, 
select or create a new choice, set the Type to Remote Control and click 
Edit…  On the edit screen, select which remote control you want to run, 
and whether the caller should return to the menu after the script, or be 
hung up on.  You may also set a greeting for the script, which is most 
convenient if your script may take a long time to run – your greeting could 
simply say “please wait while we process your request” or some similar 
message.  Once the script completes, the sound file or text-to-speech will 
be played to the caller. 

Page and Pause Choices 

The Page and Pause choice type enables the building of a simple auto-
attendant system.  A Page and Pause choice plays a simple message to 
the caller, and then sends a call announcement to the computer screen 
indicating which choice was taken.  For instance, you might tell the caller 
“Your call is being transferred to the sales team”, and then PhoneValet 
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will pop up an announcement on the computer screen to tell you that the 
call is for sales.  If you don’t answer the call within a certain amount of 
time, then PhoneValet can take the caller to a given mailbox to take a 
message.  The caller hears a hold message/music that you provide during 
the time they are waiting. 

This process gives the caller the impression that you have an expensive 
automated attendant system, and can allow you to let more calls go to 
voice mail, with the knowledge that if callers pick certain high-priority 
choices in your call tree, you’ll have the option to take the call. 

Page and Pause also works along with PhoneValet Anywhere to send 
page messages across your computer network to all your Caller ID client 
computers.  This can allow you to let PhoneValet initially answer most or 
all of your calls, and then the page feature can let people know who the 
call is for.  If no-one suitable to answer the call is available, the call can go 
to a mailbox. 

When configuring a page and pause choice, you provide an initial 
prompt/greeting to play the caller and another hold message/song to play 
during the hold period.  You also set the name of the person or 
department that you want paged.  The announcement sent to the local 
and remote computers looks a lot like the normal Caller ID 
announcement, but it includes the person/dept. name you set as well as 
the Caller ID information.  You can set the page to repeat after a set 
duration if you want, if the call is not answered. 

You also set the amount of time the line should be held before the caller 
gets sent on.  For instance, you may let the caller hold for up to 1 minute 
for a person to answer.  If no-one picks up the line, PhoneValet can send 
the caller back to the previous menu, back to the main menu, or can send 
the caller to another choice – likely a mailbox that can take a message for 
the appropriate person/department. 

Creating Shortcuts or “Extension Numbers” 

When making choices, you will notice a checkbox at the bottom of the 
choice editing area.  This lets you set a shortcut for accessing choices 
from the main menu, even though they are deeper down in the call tree. 

For instance, you may have a tree set up to help callers find people in 
your company – where people select the department they want, and then 
go through a list of people.  If callers know who they want, it may be 
convenient to enter that person’s shortcut number to go directly to their 
mailbox, as if it was their extension number.  To do this, simply check the 
box at the bottom to allow access to choices from the main menu, and 
enter a number.  Make sure the number does not conflict with the choices 
you offer at the top level of the call tree. 

You may wish to set all your shortcut numbers to have a common prefix 
(like using 901, 902, 903, etc...), and then not using 9 for any of your main 
menu choices.  PhoneValet will warn you if you make shortcuts that 
conflict with the main menu choices. 

Changing Greetings 

The Edit Greeting screen lets you listen to the current set 
greeting/prompt, and to change it.  There are three ways to set a greeting 
– by recording one on your computer’s microphone, by using Apple’s text-
to-speech system, or by using a pre-made sound file that you already 
have. 

The Edit Greeting screen is used in several places in the voice mail 
configuration – see the sections on the different types of choices (Take a 
Message, Menu, etc...) for more information.  In general, you will click the 
Change… button next to a greeting to display this screen. 



 

To record a greeting, make sure you have a microphone installed, click 
the radio button to the left of the “recorded from microphone” option, and 
then click the record button ( ).  Start speaking right away into the 
microphone, and then click stop ( ) when you’re done.  To hear your 
recording, click the play button at the bottom of the panel. 

To use text-to-speech for your greeting, simply type the greeting text into 
the space provided, and click the radio button to the left of the “script 
spoken by” option.  After you’ve typed the greeting in, click the play button 
at the bottom of the panel to hear it. 

To select a pre-made audio file, click the radio option named “copied from 
audio file” and then click the Import… button to pick a sound file.  
PhoneValet supports a wide variety of sound file formats for greetings, 
including WAV, AIFF, MP3, AAC, and others. 

Call Screening 

PhoneValet has the ability to let you screen your calls – as a caller is 
leaving a voice mail message, you can have the message played live 
through your computer’s speakers.  This option is enabled in the General 

Preferences panel under the Incoming Calls tab – check the Hear 
voicemail as it is left checkbox, and select the audio output to use. 

Once the caller selects a voice mail box and hears the greeting, they hear 
a beep and can start to leave their message.  At the same time as they 
start to leave a message, PhoneValet will start to play the message 
through your computer’s speakers. 

You can set PhoneValet not to screen calls at certain times (like during 
the night), by clicking on the Set Times… button.  The times are used to 
quiet both call screening and spoken call announcements. 

File Formats 

PhoneValet supports recording voice mail messages (and call recordings) 
in one of a few file formats.  You select these from the PhoneValet 
application’s General Preferences panel, under the Recordings tab.  
Parliant strongly recommends selecting the 3GPP format, since it offers 
superb audio quality and very small files (76 KB/minute).  The AAC format 
(300 KB/minute) is provided for compatibility with iPod devices, and is not 
recommended unless you have a specific need for that file format.  The 
final option is the WAV format which is the largest (470 KB/minute).  You 
might select WAV format if you intend to edit or convert the audio yourself 
for radio interviews, podcasting, and other uses, since this is a lossless 
uncompressed audio format. 

Parliant also offers an alternate 3GPP format which is more compatible 
with Treo smartphones, and an alternate AAC format optimized for 
iPhone.  iPhone users who use PhoneValet Anywhere do not need to 
select the iPhone format – PhoneValet Anywhere for iPhone automatically 
converts audio files on-demand when played from iPhone. 

The 3GPP and AAC formats require a recent version of QuickTime (6.5 or 
higher) or other third-party sound software to be played and can also be 
played on Windows PCs with QuickTime installed.  If QuickTime won’t be 
available on the computer you’re copying/emailing to, then the WAV 
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format is recommended – that format can be played on virtually any Mac 
or Windows computer with no extra software installed. 

Calling in to Check Messages 

You can listen to and manage your voice mail messages from a remote 
location by calling in to PhoneValet on your Mac.  This works as follows: 
you call in and let PhoneValet’s voice mail answer the call.  You then 
press star (*) during the greeting, wait for the double-beep, and then enter 
your secret code, followed by the pound (#) button to enter message-
check mode.  You can set codes for access to all messages or for access 
on a per-mailbox basis, as described above. 

The system will tell you how many messages you have, and you may 
then press 1 to hear only your new messages, 2 hear only your flagged 
messages, or 3 to review all your messages.  Your new messages are 
those that are shown in bold with blue phone icon ( ) in the ‘flag’ column 
of the call log.  Flagged calls have a red flag icon ( ).  In all cases, you 
review your messages in order starting with the most recent. 

PhoneValet will start playing you the message, telling you who called and 
when, and then letting you hear the message that was left.  You can 
press star (*) at any time during the message playback to skip to the end 
of that message.  At the end of the message, the system presents you 
with a menu of options – you can press 1 to replay the current message, 
2 to move to the next message (the current message will no longer be 
listed as new), 3 to erase this message, 4 to flag the current message.  
Erasing the message will preserve the call information in your call log, but 
the message audio file is deleted permanently – use this option with care!  
You can also press pound (#) to skip to the next message (leaving the 
current message as new), or press star (*) to return to the main menu as 
above.  All the options (1, 2, 3, 4, #) are also available during the 
message, so you don’t have to wait for the menu – if you select one of 
those options, it will automatically perform the correct action. 

New messages remain listed as new for the duration of the call (even if 
you return to the main menu or press 2 on the message), but will be 

marked as normal once you hang up.  If you erase a message, this takes 
effect right away, and cannot be un-done. 

Receiving Faxes 

Since the PhoneValet voice mail answers all calls, it could prevent you 
from receiving a fax with a fax machine or any fax software that runs on 
the same phone line.  Many homes and small businesses do not wish to 
have an extra line just for faxes, and instead share a line for both voice 
and fax calls.  PhoneValet offers three options for receiving faxes: using a 
shared-line fax machine, by using the Mac OS X built-in fax features, or 
by using the more feature-rich PageSender software. 

Many fax machines support shared-line fax receiving, including many all-
in-one printer/fax/scanner devices.  These devices eavesdrop on your 
phone calls, and if they detect a fax coming in, they pick up the line and 
receive the fax.  PhoneValet’s voice mail feature is compatible with this – 
if it detects a fax coming in, it will stop the voice mail process, and hold 
the line open silently until the fax machine picks up to answer. 

If you prefer to receive faxes using your computer, PhoneValet 
interoperates with the PageSender product from SmileOnMyMac and the 
Mac OS X built-in faxing.  A demo of PageSender is included in the 
Extras folder on the PhoneValet Message Center CD, or you can 
download/buy the latest version from http://www.smileonmymac.com/.  
Use of PageSender or Mac OS faxing requires a fax/modem of your own, 
such as the internal modems that Apple includes in most Macs.  You must 
connect the phone line to both the Parliant Telephone Adapter and the 
modem (using a splitter such as is provided with PhoneValet – three-way 
splitters are available at almost any electronics/phone store). 

To setup faxing, simply go into the Voice Mail Preferences and click on 
the Settings item on the left side. Then, check the “Notify – of incoming 
faxes” option, and select the line that your faxes come in on and which of 
the two software methods you want to use. 
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For PageSender, go into the Page Center Fax Center’s Preferences 
panel, and make sure that your PageSender preferences are correct. 
Make sure to set PageSender NOT to answer calls after you’ve set your 
fax-receive preferences (click on the Receive preferences and un-check 
the “Receive faxes after <#> rings” option).  PhoneValet will automatically 
ask PageSender to answer fax calls as needed. 

For Mac OS X faxing, open the System Preferences application (it’s on 
the Apple menu, top-left), click on the Print & Fax section, then click on 
the Faxing tab.  Make sure your fax preferences are setup as desired, 
and after they are make sure to un-check the Receive faxes on this 
computer option.  PhoneValet will automatically ask the Mac OS to 
answer fax calls as needed. 

Once setup as above, if PhoneValet’s voice mail detects an incoming fax, 
it will ask the selected software to answer the call.  Once the fax software 
answers the call, the voice mail system will hang up to let the fax be 
received.  For performance on older computers with PageSender, it is 
best to leave the Page Sender Fax Center application running all the 
time, to avoid the need to start the software each time a fax comes in. 

The Phonebook 

The PhoneValet phonebook can stores the names and phone numbers of 
the people you talk to.  Numbers should be entered into the phonebook 
for several reasons – first, it allows you to dial those names with the click 
of a mouse, or using the voice dialing feature.  Second, if you have Caller 
ID, the names you enter will be displayed (and spoken out loud to you!) 
when those people call you. You can also configure custom ringtones and 
greetings for people and block calls based on phonebook entries too. 

The Phonebook is not intended to replace your address book or contact 
manager software; simply to provide a way to setup names and numbers 
for dialing and custom announcements.  See below for information on 
importing names and numbers from other software programs. 

 

Address Book vs. the Phonebook 

PhoneValet provides a shared Phonebook as well as Address Book 
support.  The built-in Phonebook is provided for two reasons – for people 
who do not use Apple’s Address Book, as well as for Macintosh 
computers where there are multiple users.  Since the Address Book is a 
personal resource, the cards in a given users’ address book are only 
available while that person is logged into the computer.  

By contrast, the Phonebook is always available for PhoneValet to look up 
numbers in – even when no-one is logged in. 

If you were not logged in during calls that may have matched names in 
your address book, or if you have just added a name to your address 
book or phonebook, you can click on the Call Log, and select File -> 
Match Calls to Phonebook… to back-fill the un-matched calls with 
names from your phonebook or address book. 

- 11 - 
© 2004-2008 Parliant Corporation 



- 12 - 
© 2004-2008 Parliant Corporation 

Adding Names and Numbers 

To add a number to the phonebook, simply click the Add Number button 
on the toolbar.  The Details Drawer will open (if not already visible) to the 
right of the screen, as you can see in the picture. 

To add a new name, type the name into the name area. Do not put any 
extra words into the name (such as "Mr." at the beginning) unless you 
want to say those words when voice-dialing.  Then, type the number with 
area code and the 7-digit number part.  If you skip the area code, it will 
enter your local one for you.  You don't need to type in the '1' at the start 
of a long distance number - PhoneValet will do that automatically for you 
using your dialing rules (we’ll talk about those later -- dialing rules will help 
you make use of calling cards and other long-distance services).  Hit 
Save to preserve your changes when done. 

If you want to enter an international dialing number, click the 
International tab before entering the phone number.  An International 
number will dial differently (may dial “011” instead of “1” at the start).  You 
should not enter “011” into the number – that can be done in the dialing 
rules. 

If you have set up profiles for ringtones, custom greetings or call blocking, 
select the profile from the pull-down at the bottom of the details drawer. 

To dial a number, simply click on the row you want, and then click the dial 
button in the toolbar (or double-click on the row you want to dial.) 

You can delete names from the phonebook if you want – simply select 
one or more names from the list and click the Delete button, or hit the 
delete button on your keyboard.  To select more than one item, simply 
click and drag over multiple rows, or use the Option and Command keys 
on the keyboard, the same as you would use them in the Finder. 

Tips and Tricks 

You can use the Exact number type (the third tab on the right of the 
details panel) to create special dialing numbers – exact numbers will not 

have any of PhoneValet’s “smarts” applied to them, such as dialing rules, 
10-digit dialing, etc…  If, for example, you need to dial 9 to get an outside 
line, you will need to put the 9 into the exact number you type.  You can 
use the star (*), comma (,) and pound (#) symbols in exact numbers to 
create special dialing cases. See page 37 for details on this. 

If you will use the voice dialing feature, it is best to type in full names 
instead of abbreviations (Robert is better than Rob, for instance), since 
this helps the voice recognition system understand you better.  If you 
have children who want to use the voice dialer,  this is even more 
important, as their voices are harder for the computer to understand.  
Long names like “Daddy's Office” are better than short names like “Dad”. 

Note that you can enter the same phone number as many times as you 
like with different names.  For example, this means the adults in your 
house can dial with full names, but your children can dial by simply saying 
Daddy's Office or Mommy's Office. 

See Appendix A for information about other dialing options, 10-digit 
dialing, special numbers, and international calling. 

There is an Also Speak entry at the bottom of the drawer.  What you type 
here will be read out loud when a call is announced.  For instance, if you 
type in “the kids’ dentist”, and they call you, then the call will announce as 
“Call from Elaine Jones, the kids’ dentist, on line one”. 

Pronunciation of Names 

PhoneValet uses Apple’s English speech recognition system, which is 
very capable and will know right away how to pronounce most names that 
you enter, and will understand you when you say them.  The computer 
may not pronounce certain more complicated names perfectly.  To hear 
how the computer is going to pronounce a name, push the Say it button 
next to where you’ve just typed the name you are adding to the 
phonebook. 

If the computer does not pronounce the name as you expect, simply type 
the name phonetically in the Sounds Like field, right under the name.  



For example, to get PhoneValet to correctly pronounce the name of our 
company (Parliant), you would type “Par lyant”.  This has two benefits; it 
will teach the computer how to correctly pronounce the name, and it can 
help the computer understand you for voice-dialing. 

Searching in the Phonebook 

PhoneValet has a simple but powerful searching system to help you find 
names or numbers in the phonebook.  At the top right hand corner of the 
phonebook window (see the picture below) there is a text box labeled 
Quick Search you can type in.  Simply type in something and as you 
type, the phonebook list updates to show only matching search results.  
You can type some or all of a name or a number - it searches 
automatically in both columns. 

 

To cancel a search and return to the full list of names, simply click the (X) 
button at the right of the search field. 

You can also sort the list by name or number by clicking on the column 
titles of the table - simply click on the word Name or Phone Number in 
the table headings.  If you want to reverse the sorting, simply click on the 
same title a second time.  Normally, the list is sorted alphabetically by 
name. 

Phonebook Notes 

PhoneValet also lets you enter a note for each name in your phonebook.  
This is a free-form area where you can enter as much text as you like. 

 

You enter notes by clicking on a name in the main phonebook screen, 
and typing into the notes area at the bottom (see picture below).  When 
there’s a note entered for a number in the phonebook, a little pencil icon 
appears in the notes column. After you type a note, pick Save 
Phonebook Number from the Phonebook menu to save it. 

 

 

Address Book Integration 

PhoneValet offers extensive integration with Apple’s built-in Address 
Book.  Just like with the Phonebook described above, PhoneValet will 
look up callers in Address Book for call announcements and for placing 
the name into the call log.  You can also click on numbers to dial from 
within the Address Book window, or dial these names using the voice 
dialing feature. You can use the Address Book tab in the PhoneValet 
main window to customize the way to speak names of callers and to set 
the way in which to dial their phone numbers. 
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Customizing call handling with Address Book 

You can customize the call announcements and dialing handling for 
people in your address book by using the Address Book tab in 
PhoneValet’s main window.  If you don’t see the Address Book tab 
(would be named with your user’s name – i.e. “Bob Smith’s Address 
Book”), then you need to enable address book integration, which you can 
do on the Other tab of the PhoneValet General preferences panel. 

You will see one entry in PhoneValet for each phone number in your 
address book – this allows you to customize the announcement of calls 
from each number separately.  The names show up with the telephone 
labels attached – for instance, Bob Smith Work, Bob Smith Mobile, etc… 

Working in the Address Book tab is very similar to the phonebook.  You 
can search within your address book records by name/number using the 
Quick Search field, and you can sort the address book records by 
clicking on the column headings.  When a person is selected, you will see 
the Notes area at the bottom of the window.  This area shows you the 
same information as is displayed in the Note field which is at the bottom 
of an Address Book card.  See the phonebook section above for details 
on these features. 

 

If you select a person in the Address Book tab, and click the Details 
toolbar button to open the drawer, you can customize the way calls are 
dialed and announced.  You can set a Sounds Like for the person’s 
name, to correct the pronunciation of names that Apple’s speech system 
doesn’t handle.  You can also type additional information about a person 
in the Also speak area – this information will be read out at the end of a 
call announcement, and can be helpful to indicate to people who the 
caller is.  See the phonebook section above for more details. 

To customize dialing, you can edit the phone number as needed, and use 
the pull-down beneath to control whether or not you want PhoneValet to 
figure out how to dial the number, or if you need to specify that a number 
is long distance or use a calling card.  Right below the pull-down menu is 
a preview of how the call will be dialed. 

If you have more than one card in your address book with the same 
phone number, you may wish to pick which person’s name will be shown 
on calls to/from that number.  To pick the person, select their name in the 
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table, and then in the drawer, check the Always match this person… 
checkbox.  Otherwise, PhoneValet will select the first person with the 
given number for call announcements and logging. 

At the bottom of the drawer, PhoneValet shows you if a profile is active for 
the given phone number.  You can click the Set Profile… button to open 
the profiles panel – see page 15 for information about profiles. 

Profiles: Call Blocking, Ringtones and Custom Call 
Handling 

Based on the telephone number of a phone call, you can use Profiles to 
customize how your callers are handled when they call you.  You make 
profiles that describe what to do when calls come in – playing ringtones, 
blocking calls, etc. You then assign profiles to people listed in your 
phonebook (in the Details drawer) so that calls from those people are 
handled specially.  You can assign the same profile to as many 
phonebook entries as you like.  You can also match profiles to other 
telephone numbers directly on the Profiles screen, for people not in your 
phonebook. 

For calls where Caller ID doesn’t send a number, you can assign a profile 
that will apply to calls that are reported as “out of area” by Caller ID. 
Another profile can be used to handle Caller ID “private numbers”, where 
the caller blocked their phone number. 

Profiles can do one or more of the following things when a caller calls in: 
• Play a ringtone (sound) 
• Send caller to voice mail immediately 
• Block the call by playing a message and then hanging up 
• Play a custom greeting to the caller instead of the normal main 

greeting 
• Send the caller to a specific mailbox directly 
• Force call recording on or off 

Creating Profiles 

To create profiles, click on the main menu, and click on Preferences and 
then Profiles…  From the window that comes up, you can add, edit, 
duplicate and delete profiles.  At the bottom of the panel, you can set the 
profile to use for “out-of-area” and “private” callers. 

 

In the middle is a place to type names or numbers for Caller ID matching, 
and the profile to go with them.  Type a complete phone number and pick 
Match Whole Number or type in some or all of a name and pick Match 
in Name.  You can also select Match area code only and type in an area 
code – this will match any phone number that has that area code.  Name 
matching matches the name as sent by Caller ID, or the name of the 
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caller as taken from your address book card for that number.  Be careful 
not to make names too short – they could match unintended callers – for 
instance, don’t enter “Bob” to match “Bobs Towing”, since other callers 
named Bob will be treated the same way!   In the same way, be careful 
with blocking calls by area code – consider all the possible callers that 
could call from that area code! 

If you add or edit a profile, you will see the profile editing screen with 
three tabs. 

 

Under the Ringtone tab, you can specify a ringtone to be played when a 
call comes in – to do so, check the Play ringtone… box, and click the 
Change… button to set the ringtone.  Similarly to the voice mail greetings 
setup, you can make a ringtone by selecting a sound/music file, by 
recording from a microphone, or using text-to-speech.  Ringtones can be 
repeated as many times as you like until the phone is answered, and you 
can set the number of repeats under the up to <> times field – the default 
is to play the ringtone once. 

Voice Mail options are available from the second tab.  Each of the 
options can be used separately, or in combination with each other.  Here 
are the options and what they mean: 

• Answer 

This option adjusts when PhoneValet will answer calls for voice 
mail.  Selecting Immediately will cause PhoneValet to answer 
the call and go to voice mail as soon as the Caller ID is received, 
rather than waiting for the normal number of rings.  In most 

countries, this will happen between the first and second rings of 
the phone.  In the UK, Caller ID comes in before the first ring, so 
the phone may not ring even once.  You can also enter a specific 
number of rings using the After _ rings options. 

 

• Override the first greeting the caller hears 

This option overrides the greeting the caller would normally hear 
when PhoneValet first answers the phone.  The caller will not 
hear the regular main greeting, only the custom greeting you set 
up.  To set the greeting, click the Change… button. 

• Choices available to the caller 

This option sets what options the caller has once the PhoneValet 
voice mail has answered the call.  The “All usual choices 
available” option means that the caller is taken to the normal 
starting point for voice mail.  This option also permits the caller to 
select Remote Control mode using (*). 
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The “Hang up after delivering greeting” option is used for call 
blocking or delivering custom messages where you don’t want 
the caller to be able to leave a message.  For call blocking, you 
should override the first greeting (as in the previous option) with 
one that says “Your call has been blocked” or something to that 
effect.  As soon as the greeting has been played once, the call is 
dropped.  The caller in this case may not leave a message, and 
cannot use Remote Control. 

The “Caller is sent directly to choice” option allows you to 
drop the caller directly into a particular place in the call tree, 
without playing them the normal main greeting and giving them 
the standard mailbox choices.  You select the desired voice mail 
choice by clicking Set… and picking from the available call tree 
choices.  The caller is taken directly to that particular choice 
when the call is answered – the caller can be sent to any kind of 
choice, including a sub-menu. 

Call Recording options are available on the third tab. 

 

The Override automatic call recording settings… option lets you force 
call recording to be on or off for calls to or from the numbers that you 
associate with this profile.  This will override the global call recording 
settings.  For instance, you may want to exclude your personal calls 
(family/friends) from being recorded on your business phone line. 

 

 

About Blocking Calls and Faxes 

The “Hang up after delivering greeting” option is used to block calls, as 
described above.  To prevent the phone from ringing many times, make 
sure to also activate the “send the call to voice mail right away” option.  
To make best use of this feature, you should set a custom greeting using 
the “Override the first greeting” option.  Otherwise your normal main 
greeting will be played (which probably tells the caller what options are 
available), but of course these options are not available to this caller since 
PhoneValet is about to hang up on them. 

If you intend to block calls from known fax numbers and you have a 
shared-line fax machine, you should set a very short custom greeting to 
prevent a fax machine on the line from answering.  These fax machines 
monitor the phone line listening for fax calls, and answer as needed.  In 
some cases, these fax machines are very “aggressive” at trying to 
answer, and may pick up the call before PhoneValet has a chance to 
hang up.  If this happens, you may want to set a loud noisy custom 
greeting – in some cases this can prevent the local fax machine from 
“hearing” the calling fax machine until PhoneValet has hung up. 

If you are blocking faxes and are using software like PageSender or the 
Mac OS X fax integration, then you do not need to do this trick – 
PhoneValet will not transfer blocked fax calls to those software packages. 
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The Activity Monitor 

The Activity Monitor lets you watch what’s going on with your phone 
line(s), provides access to the call recording feature, and allows you to 
send calls ringing in directly to voice mail.  You can watch in “real time” as 
calls are dialed, answered, sent to voicemail, and even find out what 
mailbox the caller is leaving a message in. 

The Activity Monitor is designed to be small enough that you could leave 
it on-screen all the time if you wanted.  To show the Monitor window, click 

on the PhoneValet menu bar icon ( ) and select the Recording and 
Activity Monitor… option. 

 

 

For each line, you will see the current status of the call (ringing, in voice 
mail, call in progress, etc…), and under the Call column, you will see the 
number of the caller or the number you dialed.  If you have more than one 
line, simply resize the window to show all your lines – the default window 
is only tall enough for one line’s information. 

If a call is ringing in, click on the cassette-tape button ( ) to send the call 
to voice mail right away.  The caller is sent immediately to voice mail with 
the main greeting, and your phone should stop ringing right away.  This is 
convenient to use if you are too busy to take the call, or you don’t want to 
speak to the caller at that time.  This button is only enabled when a call is 
ringing in, and after Caller ID is received (or after the second ring if you 
don’t have Caller ID service). 

Call Recording 

PhoneValet offers the ability to record your telephone conversations.  
When you do so, PhoneValet listens to your phone call, and records both 
ends of the conversation into a sound file.  When the call is over, you can 
simply click on the given call in the call log to listen to the recording.  You 
can record calls on multiple lines at the same time. 

Calls can be recorded manually, or automatically.  Manual recording 
involves clicking in the PhoneValet user interface to start recording only 
for specific calls.  Automatic recording involves PhoneValet starting and 
stopping recording automatically each time you place or answer a call. 

Manual Recording 

To initiate recording, display the Activity Monitor as described above, 
pick up the phone to start your call, and then click the microphone/record 
button ( ) to start recording.  The button will immediately turn into a stop-
recording button ( ) which you can click to stop recording.  Note that you 
can only start recording when a phone on that line is off-hook – if no 
phone is off-hook, the recording button is disabled.  If you want to record 
yourself dialing the call, feel free to start recording right after picking up 
the phone (when the dial tone is still heard,) and then dial the call with the 
phone. 

Once you start recording, it will run until the end of the call (i.e. you hang 
up), or until you stop it with the panel’s stop button as above.  If you stop 
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recording during a call, you can start it again later on.  If you restart 
recording, you will end up with a single recording for the call with a beep 
inserted at the point where you paused.  You may stop and restart 
recording as often as you wish during a call. 

Automatic Recording 

Automatic recording leverages PhoneValet’s ability to track the start and 
end of your calls.  PhoneValet can start and stop call recording 
automatically without you needing to be near the computer.  This option is 
enabled in the General Preferences, under the Recordings section; you 
can enable automatic recording for placed calls, answered calls, or both. 

For placed calls, PhoneValet will start recording 5 seconds after you finish 
dialing the number for the call.  This delay is to ensure that PhoneValet 
doesn’t miss any of the digits you are dialing – so that your call log has an 
accurate record of the number you’re calling.  Recording will stop as soon 
as you hang up the call. 

For answered calls, recording will start as soon as PhoneValet detects 
that you have picked up the phone to answer.  Again, recording will stop 
when you hang up. 

If you want to stop recording during the call, you can still do that as you 
could with manual call recording (see the previous section).  The Activity 
Monitor window will show you that your calls are being recorded, even if 
the recording was started automatically.  As described above, you can 
click the stop and restart buttons to control recording. 

Call Waiting 

While recording calls, you should not take calls that come in by call 
waiting service.  Call waiting works by playing a tone into the phone when 
a second call comes in.  You then “flash” the line (flash means briefly 
hanging up and then picking up the phone again) to take the second call, 
and the first call remains “on hold”.  Many phones have a “flash” or “link” 
button that switches calls for you, and this button performs a line flash for 
you. 

When taking a call waiting call you are essentially hanging up on the first 
call and starting the second. Because of this hanging up and picking up, 
PhoneValet will believe that you are ending the call when switching calls, 
and will stop recording and mark the call as ended in the call log. 

If you want to take the second call (even though recording will stop), the 
flash/link button will likely not actually work the first time you press it, 
since PhoneValet is on the line with you recording the call.  By flashing, 
you will end the call in the log and stop recording.  After that, wait a 
couple of seconds and do a flash again, and this time it will switch calls 
for you.  At that point, PhoneValet will not record the call, but you are free 
to switch back and forth between the callers.  Alternately, you can click on 
the stop-recording button if you are at the computer, wait a couple of 
seconds, and then flash the line to switch calls. 

If you are going to record important calls, or you don’t want the call 
waiting beep sounds in your recordings, you may want to disable call 
waiting. With most phone companies, there is usually a star code that you 
can dial before placing a call (often *70; check with your phone company) 
– this will prevent call waiting during that one call. 

Sound Files and Audio Quality 

The call recordings are stored in standard sound files, and you select the 
format for files from the Recordings section of the General Preferences 
panel.  As with voice mail, Parliant recommends the 3GPP format, since 
in our experience it offers the best sound quality and smallest file size.  If 
you need to share your call recordings with Windows PC users, the best 
choice is the WAV format. 

A common problem with call recording products is that you sound much 
louder than the person you’re calling in the recording.  The Parliant 
Telephony Adapter has automatic volume control which tries to 
compensate for the difference in volume between you speaking locally, 
and the remote caller who probably sounds much quieter.  To improve the 
sound quality of the remote caller’s voice, try to reduce background noise 
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(music, fans, etc...) around you – many phones will pick up a lot of 
background noise and that noise could make it into the recording. 

Remote Control 

Remote Control is a feature that works along with the voice mail feature to 
let you dial in and run programs on your computer from away.  You can 
set up any number of AppleScripts to run based on secret codes that you 
punch in when calling in.  Scripts can do anything that’s possible with 
AppleScript – read you the weather, ask your computer to reboot, read 
you your calendar appointments for today, play you a song, etc… 

A remote-control AppleScript is just like any other AppleScript, but 
PhoneValet will provide the script with the caller’s details and other 
parameters that are useful for writing the script.  Also, the script may 
return a sound file to be played back to the caller, or some text which the 
computer will read back to you using Apple’s text-to-speech system. 

To enter remote-control mode, call in to the voice mail from away. While 
the voice mail greeting is playing, dial star (*) on your phone.  The system 
will beep twice to indicate you’re in remote-control mode.  Then, to run 
one of your scripts, simply enter that script’s secret code followed by the 
pound (#) key.  Depending on the script you write, the system will say 
something back to you, play a sound file, or simply quietly run the script.  
After the script is done, you’ll get another double-beep indicating you can 
enter a new code.  You can run up to 5 scripts per call. 

Remote Control is also the method to call in to check messages.  If you 
have set access codes in the voice mail preferences for access to all 
messages or for specific mailboxes, you can enter them as above. 

To configure Remote Control scripts, click on the main menu and select 
Preferences → Remote Control…  In the panel, add a script using the 
Add Control button, and then assign a numerical code to the script, 
select the script file to run, and enter the parameter (if your script wants 
one).  You also need to select what kind of information the script returns – 

does it return nothing (i.e. it will run silently), does it return some text to be 
spoken to the caller, or does it return the filename of a sound file to be 
played? 

Example Scripts 

Parliant provides some useful example scripts to let you see what kinds of 
things can be done.  These examples are pre-installed in the correct 
location on your computer, but you need to set them up to run, by adding 
them to the scripts list and assigning them secret code(s) as above. 

The TodaysICal script will read you the list of current events and times 
listed in your iCal calendar.  Simply add the script, assign a secret code 
and set the Feedback type to be Text to be spoken. 

The Todays Now Up-to-Date script is similar to the above, but reads you 
your events as listed in your Now Up-to-Date calendar. As above, set the 
Feedback type to be Text to be spoken. 

The US Weather script will read you the weather, as provided from a US 
National Weather Service web site.  To use this, add the script, assign it a 
secret code, set the Feedback type to Text to be spoken and then enter 
your ZIP code in the Parameter column.  This script only works with 
some ZIP codes based on the services provided by the NWS – if your ZIP 
code doesn’t work, try another ZIP code near your location. 

The Canadian Weather script will read you the weather, as provided from 
an Environment Canada web site.  To use this, add the script, assign it a 
secret code, set the Feedback type to Text to be spoken and then enter 
your nearest airport code (such as yyz for Toronto, yow for Ottawa, yvr for 
Vancouver, yul for Montréal, etc…) in the Parameter column. 

The PlayGivenSoundFile script will play the sound file as specified in the 
Parameter column – simply type in the complete path to a sound file (in 
Unix-style /path/to/file or Mac-style Macintosh HD:path:to:file formats).  
Set the Feedback type to Name of sound file to play. 



Dialing 

PhoneValet permits you to dial from the computer in many ways: by voice 
using your computer’s microphone, by clicking in the call log or 
phonebook, by using the Apple Services menu, or directly from the Apple 
Address Book.  Our menu-bar item permits dialing from the pasteboard, 
and dialing is scriptable using AppleScripts. 

PhoneValet makes use of Apple’s advanced speech recognition, and will 
work seamlessly with other speech features like Apple’s “Speakable 
Items” voice commands.  You do not have to “train” the system to 
understand your voice in advance of using it, as is common with other 
speech recognition systems - simply type the names and numbers into 
your phonebook and you can voice dial right away! 

Dialing by voice 

Unless you have customized Apple’s speech system, you will know that 
voice dialing is available by this little window being visible on your screen: 

 

This is called the feedback window and is on-screen whenever a program 
is ready for spoken commands. By default, the system will only listen to 
you when you hold down the ESC key on your keyboard, but this can be 
changed.  The key required is printed in the light blue area in the center of 
the feedback window. 

To try out voice dialing now, simply hold down the ESC key and say “Call” 
and then say a name from your phonebook or Address Book, for instance 
“Call Bob Smith”.  You can also say “Phone” or “Dial” instead of “Call”. 

PhoneValet will listen to the name you spoke, and look up that name in 
the phonebook.  If you have enabled Address Book integration, then you 
can also speak names from your Address Book.  After speaking, this 
panel will appear on screen: 

 

To start the dialing, simply pick up the phone and dialing will begin – the 
panel will go away as soon as the dialing starts.  If it displays the wrong 
name, you can simply click Cancel on the dialing panel and try again.  If it 
doesn’t understand what you said, three little question marks “???” will be 
printed in a bubble right above the speech feedback window – all you 
need to do is speak again. 

Tuning the speech system 

If the system has trouble recognizing you, there are two things to do.  If it 
is a particular name that isn’t working, then use the Sounds Like field in 
the phonebook details screen to customize the pronunciation.  Use the 
Say it button to make the computer’s pronunciation match yours’. 

If the system fails to recognize you on many names, you can use the 
System Preferences speech panel to tune your speech settings.  Simply 

click on the PhoneValet icon in the menu bar ( ), select Voice Dialing, 
and then Open Speech Preferences… option, or launch the System 
Preferences program (available on the Apple menu) and click on the 
Speech icon.  There is a very useful microphone volume control that 
tunes the system to recognize your voice even in areas where there’s lots 
of background noise. 

For details on tuning the microphone and speech systems, simply search 
for “speech” in the help for Apple’s System Preferences. 
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Services Menu Dialing 

PhoneValet adds items to the Services menu to allow you to dial from a 
wide variety of Mac applications, simply by highlighting the number and 
clicking on the menu.  Apple’s Services menu appears in the main menu 
(the menu with the application’s name in bold) of many Mac OS X 
applications. 

If you’re in a program that is displaying a phone number, select (highlight) 
that phone number with the mouse, click on the Application’s menu, then 
on the Services menu and pick Dial Number with PhoneValet, and then 
pick either “Automatically”, “By Selecting a Dialing Rule”, or “Exactly 
as Typed” from the submenu.  The dialing panel will pop up and you can 
pick up any phone to start the dialing, same as above with voice-dialing.  
If you want to select a dialing rule, you will first be offered a window with a 
list of your dialing rules to choose from. 

Note that some applications do not implement the Services menu; in 
those applications you will see a Services menu with no items in it, and 
this feature will not work.  For those applications, you may want to use the 
Clipboard dialing feature described below. 

Address Book Dialing 

PhoneValet integrates with Apple's Address Book application to allow you 
to dial phone numbers directly from within the Address Book application. 

As you see in the screenshot below, you can click on the menu 
associated with any phone number and pick one of the PhoneValet 
dialing items.  The Dial item will cause PhoneValet to examine the 
number, and attempt to automatically apply your dialing rules and 10-digit 
dialing preferences to decide how best to dial the number.  If you want to 
select a specific calling card or dial a number exactly as given, select the 
alternate menu items. 

 

Clipboard Dialing 

PhoneValet offers clipboard dialing from the menu-bar item at the top-

right of the screen ( ). This is offered to provide dialing from 
applications that don't support services, such as Mac OS “Classic” 
applications.  To use this feature, copy a phone number onto the 
pasteboard from any application.  Then, click on our menu-bar icon and 
select an option from the Dial from Clipboard submenu. 
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AppleScript dialing 

PhoneValet provides a dialing service to AppleScripts by providing three 
simple commands that match the dialing options as above. 

The commands are "dial number" (for automatic use of PhoneValet 
dialing rules), "dialExact number" (for dialing exactly the digits given) and 
"dialWithChoice number" (which will prompt the user for a calling 
card/dialing rule). 

A simple AppleScript to dial looks like the following, which will 
automatically process the number 123-456-7890 for long-distance dialing 
rules and then dial it. 

tell application "ValetDialer.service" 

   dial number "123-456-7890" 

 end tell 

PhoneValet ships with some example scripts in the "Extras" folder on the 
product CD.  Additional examples will be provided on Parliant's web site 
at http://www.parliant.com/support/phonevalet/ 

One example is automatically installed; a set of dialing scripts for 
Microsoft's Entourage email program.  If you have Entourage on your 
computer, these scripts are installed when you run PhoneValet, and are 
available from Entourage's scripts menu.  To use the scripts, highlight a 
phone number in the text of an email, and select the appropriate 
PhoneValet dialing option from the scripts menu.  Another script 
(PhoneValet – Dial Contact) allows you to highlight an email message to 
dial the sender, or highlight a contact in a list to dial that person. 

Call Logging 

PhoneValet records all numbers you dial from any of your connected 
phones.  PhoneValet will track and record the numbers and save the 
entries in your Call Log.  For each call you make, it records the name (if 

known), the number, the date, the time the call was started, and the 
duration of the call.  If you have multiple phone lines and multiple 
Telephone Adapters, then the Call Log will keep track of calls on each of 
your connected lines.  One report will list all of the calls, and can be 
sorted by each individual phone line. 

The Call Log also serves as the archive for all your voicemail messages 
and call recordings. 

There are many keystrokes that allow you to navigate the calls and 
play/pause messages using only the keyboard for fast access.  Look on 
the Call menu to see a list of actions and their key equivalents. 

Caller ID 

Caller ID is a service provided by your local phone company (sometimes 
called Call Display), that tells you the number of the person calling you, 
as the call comes in.  If you subscribe to Caller ID service, PhoneValet 
will store information on the calls you receive.  This is identical to your 
Outgoing Call Log – date, number called, name, time call started, and 
duration of the call. 

Caller ID service has a name service option (included by many phone 
companies, optional with others), which tells you the name of the caller 
as well as the number.  Caller ID does not generally permit long names.  
It would announce “Michelangelo’s Pizzeria” as something like “Mic. 
Pzza”.  However, if you have entered a name into the phonebook for the 
given number, that name will be announced in full, just as you have 
entered it in the phonebook.  If you have not entered the name in the 
phonebook, the name provided by the Caller ID service would be 
announced as the call comes in, and recorded in the log. 

Dialing Numbers from the Call Log 

If you are at your computer and you see a number in your call log that 
you would like to call, simply double-click on the number in question.  A 
panel will come up on the screen confirming the number.  Simply pick 
up any phone, and the number will be dialed. 

http://www.parliant.com/support/phonevalet/


Making Comments in the Call Log 

You can add a note for each call in the log – you can even enter notes 
when the call is in progress.  A note can help you remember what the 
call was about, which is especially useful if you use the call log for client 
billing or tracking your phone usage.  Any comments that you enter can 
be included in call log exports that you make – for more information, 
see the Importing and Exporting chapter below.  Notes work exactly the 
same way as in the phonebook – you enter them in the Notes area at 
the bottom of the screen, and you get a pencil icon in the Notes column 
when a note has been entered. 

Adding Call Log Names to Your Phonebook 

If you see a number in your call log that you want to be able to voice-
dial later on, click on that number and select Add Number from the 
toolbar.  You will be switched to the Phonebook tab, and the name and 
number will be pre-typed for you.  Simply make any edits you want and 
click the Save button (or pick Save from the Phonebook menu). 

Reading the Call Log 

To get details for a call, simply click the details button to show the 
drawer on the right side of the main window.  You can make changes to 
the name and number of a call – mainly so you can correct missing 
information, in case you use the call log for billing or time tracking.  On 
international calls, Caller ID information is frequently not provided, so the 
call will log but there won’t be a name or number.  In this case, you can 
edit the call as you like. 
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For each call, a letter code identifies the type of call: 
• P Placed call 
• A Incoming call (answered) 
• U Incoming call (unanswered) 
• M Incoming call with a voice mail message 
• R Incoming call (Remote Control was used) 
• T Incoming call that was transferred 

You can sort the call log by name, number, type, etc… by clicking on the 
column titles.  By default, the list is sorted in date order with the most 
recent calls first.  If you click a second time in a column title, the sorting is 
reversed. 

The Msg column shows an icon when that call has a voice mail message 
(a cassette tape icon) or a call recording (a microphone icon).  For voice 
mails the Mailbox column shows the mailbox that the message was left in. 

You can delete calls from the log if you want – simply select one or 
more calls from the log and click the Delete button, or hit the delete 
button on your keyboard.  To select more than one item, simply click 
and drag over multiple rows, or use the Option and Command keys on 
the keyboard, the same as you would use them in the Finder. 

Playing Voice Mails and Recordings 

To play a voice mail or call recording, simply highlight the call in the log, 
open the Details drawer, and use the convenient sound-playing controls 
at the bottom of the details drawer. 

To remove the audio recording for a given call, click on the Audio 
Options pull-down, and select Delete the Recording.  Deleting a 
recording moves the audio file to your 
trash, as a precaution – the file is 
completely deleted when you empty your 
trash.  If you want direct access to the 
audio file that contains the 
message/recording, simply select Reveal 
Audio File in Finder from that pull-down, 
and a Finder window will open with the 
sound file selected. 

Searching in the Call Log 

PhoneValet has a simple but powerful searching system to help you find 
names or numbers in the call log.  At the top right hand corner of the call 
log window (see the picture below) there is a text box labeled Quick 



Search you can type in.  Simply type in something and as you type, the 
call list updates to show only matching items.  You can type some or all of 
a name or a number - it searches automatically in both columns.  To 
cancel a search and return to the full list of names, simply click the (X) 
button at the right of the search field. 

 

You can also sort the list by name, number, time, etc… by clicking on the 
column titles of the table.  If you want to reverse the sorting, simply click 
on the same title a second time.  Normally, the log is sorted by date and 
time with the most recent calls at the top. 

Spotlight Searching in Mac OS X “Tiger” 

Starting with Mac OS X 10.4 “Tiger”, Apple has provided a system-wide 
search tool called Spotlight.  PhoneValet includes a Spotlight plug-in 
(installed automatically) that allows searching of the PhoneValet Call Log 
from Spotlight. 

You can search on many aspects of a call – the name, number, notes, 
duration of message/recording, length of call, etc.  In the following screen 
picture, you can see a search for “lumber”, which has matched some 
calls’ notes.  Note that the voice mail calls appear in the “Messages” 
section along with emails, and other calls appear in the “Documents” 
section.  Clicking on a call in Spotlight search results will open the call in 
the PhoneValet call log. 

 

In the PhoneValet General Preferences, under the Other tab, you can opt 
to enable Spotlight indexing.  By default, indexing is on in Mac OS X 10.4, 
and indexes “interesting” calls – voice mail messages, recorded calls and 
calls with notes.  A second option called Include all calls will cause 
Spotlight to index all your calls.  For people with large call logs, including 
all calls may produce too many results in Spotlight and make it difficult to 
“weed through” the results. 

Call Log Reporting 
The Report button on the toolbar permits you to make advanced 
searches in the call log.  This is designed for those people who want to do 
more flexible searching for the purposes of building a timesheet, phone 
log, etc… 

When you click on the report button, you are given a panel that looks like 
the image that follows… 
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To search by one of these criteria, check the box to the left, and then 
enter the appropriate search terms.  You can search in a date range, 
inside the text of the name, number and notes, and by the duration of the 
call.  You can also filter calls based on which line they came in on, and 
whether they are incoming or outgoing calls. 

When you’re finished entering criteria, click the Search button.  Your 
results will be displayed in the Call Log tab.  You can simply export those 
rows to a file – see below for import/export instructions.  When you 
search, the word -REPORT- will be written in the quick-search field in the 
toolbar.  To cancel the report, and return to the complete list of calls, 
simply click the (X) button on the right of the quick-search field. 

Manage Important Calls: The New Calls Window 

The New Calls window shows you a compact view of your most 
interesting calls – those that are new, flagged, or have occurred recently.  
This list includes only incoming calls.  It is intended to be an easy to use 
way to focus on the calls that you haven’t responded to or that require 
follow-up later.  To show the New Calls window, click on that option on 
the Window menu. 

 

Using an interface reminiscent of a standard answering machine or Caller 
ID box, the New Calls window lets you review your latest calls.  The round 
navigation controls on the left side let you navigate up and down in the list 
of calls.  The most recent calls are at the top of the list, and you can click 
the down and up arrows to review your new calls.  You can click the play 
button in the center to play/pause the message for the displayed call, and 
you can use the left/right arrows to skip forward or backward in the audio 
as it plays.  Each click of a left or right arrow moves you 5 seconds 
forward or backward in the audio. 
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If you open up the call list, by clicking on the Call List button, you can 
view the list of calls for easy access.  This also displays some simple sort 
and search controls.  You can opt to show certain calls – just new and/or 
flagged calls, or recent calls from the last week or month.  You can also 
filter the list by mailbox, or type a name/number in the search box.  As 
you type, the list of calls will shrink to only those calls that match. 

The New Calls window has many keyboard navigation elements to make 
access to your messages easy – you can use the space bar to 
start/pause message playing, the up/down arrow keys to move through 
the list of calls, and the right/left arrows to move 5 seconds back/forward 
in the playing message.  Look on the Calls menu for the keyboard 
shortcuts for other options – almost every navigation action has a key 
equivalent. 

When you have one or more calls selected, you can click the New and 
Flag buttons to change the calls.  If you want the call to no longer be new 
or flagged, simply click the highlighted button, and the call will change to a 
‘normal’ call.  You can also click Return Call to call back the number for 
the selected call, or click Email Message to email the call details and 
message.  If the selected call was from a number listed in your 
phonebook or Apple’s Address Book, the right-most button will change to 
read Phonebook or Address Book as appropriate.  Clicking this button 
will open the main PhoneValet window and highlight the caller’s number 
in the list.  This button is disabled if the caller’s number did not match. 

Caller ID Announcements 

PhoneValet has a convenient feature for announcing the names of 
incoming callers using your computer's speakers and on-screen.  To use 
this feature, you need to subscribe to the Caller ID service from your local 
phone company.  This feature can save you having to run over to the 
phone or Caller ID box to find out who's calling, especially if you don't 
want to answer the call! 

Caller ID announcement can be turned on and off in the preferences.  
You can also instruct PhoneValet not to speak callers’ names at certain 
times (like during the night) and pick the size of the on-screen 
announcement window.  To do this, go into the preferences screen (click 
on the PhoneValet menu and pick Preferences → General…), and click 
on the Incoming Calls tab. 

If you have the caller's name/number in your phonebook, then 
PhoneValet will speak and display that name.  Otherwise, PhoneValet will 
use the name of the caller as provided by your Caller ID service.  See the 
section Caller ID above on page 23 for details about Caller ID service and 
name display options.  The Caller ID service does not provide full names 
if they are long.  For instance, “McDonald’s Restaurant” might be 
displayed as “McDlds Rst”.  PhoneValet lets you take names from the log 
of incoming calls and make them as long as you want.  Incoming calls are 
then announced and logged in the way you have chosen.  This is very 
convenient if your children call their friends, and get calls from them.  The 
Caller ID feature would only give the caller name in the way it is listed in 
the phone book.  You could identify that number the way your child uses it 
– “Susie”, for example. 

Call Announcements will come in even when the PhoneValet application 
is not running.  You must run PhoneValet at least once after installing, but 
after that, the call announcement program will start each time you log in 
and run in the background.  The same program that performs call 
announcements also displays pages generated by the page-and-pause 
voice mail feature. 

PhoneValet Anywhere extends call announcements and pages to 
computers around your network.  See page 32 for details. 

Call Actions and AppleScripts 

PhoneValet allows multiple kinds of call actions – emails can be sent on 
each call, and you can write your own AppleScripts which run when a call 
comes in, when you pick up or hang up the phone, and after voice mail 



- 28 - 
© 2004-2008 Parliant Corporation 

messages are left and call recordings are made.  For example, 
PhoneValet can update your iChat status and mute iTunes when you’re 
on the phone. 

Email on Incoming Calls 

You can configure PhoneValet to send an email each time a call comes 
in.  Email will be sent when a call comes in with Caller ID.  No email is 
sent if there is no Caller ID (or you don’t have Caller ID service), since 
there’s no information to tell you about.  There is no need for a user to be 
logged in – emails will be sent even if the login panel is showing. 

You configure this from the General Preferences panel.  Click on the 
Incoming Calls tab and enter the address to which you want the emails 
sent, as well as what kind of calls you want emails sent for.  You can also 
include voice mail message attachments (if there are any for a given call). 

You also need to click on the Other tab and enter the information your 
Internet service provider gave you for email sending.  If your email 
settings require a password, an SSL secure connection, or an alternate 
port setting, click on the Advanced… button to access these settings.  
For password-required connections, you should set the Authentication 
type to Plain if you are not sure what to pick.  If you don’t need a 
username or password, make sure to leave these fields empty – you can 
still select SSL or alternate port settings as required. 

If you are emailing to an Apple iPhone, make sure to upgrade to iPhone 
software 1.1.1 or higher in order to play audio file attachments. 

AppleScripts 

AppleScripts can be run at various times when things are happening on 
the phone line, as described below.  AppleScripts will only run if a user is 
logged into the Mac at the time. 

You configure the different kinds of AppleScripts to run by clicking on the 
PhoneValet main menu and selecting Preferences -> AppleScripts….  

In general, you copy your script into the appropriate folder (as below) and 
then enable it in the AppleScripts panel. 

Caller ID AppleScripts 

Caller ID scripts run when calls come in with Caller ID information.  
PhoneValet runs an AppleScript function and passes it all the information 
available about the caller (name, number, date).  The scripts are run at 
the same time as the call is announced on-screen (just before the second 
ring). 

For instance, PhoneValet ships with an example script that looks up the 
caller’s number using publicly available Internet reverse-lookup services.  
As the call comes in, your web browser opens to show you information 
about the person who is calling. 

Hook Status AppleScripts 

Hook Status scripts run whenever you start to use the phone line (i.e. pick 
up a phone) and when the line goes out of use (i.e. when you hang up a 
call).  The script’s function is given information about the line that 
changed, and how many other lines are already on- or off-hook. 

For instance, we ship an example script for iChat such that each time you 
start a call, PhoneValet alters your iChat online status message from 
Available to Away with a message “I am on the phone”.  When you hang 
up the telephone, it sets your status back to Available again. 

The iChat script does not prevent people from attempting to contact you 
for voice, text or video chats - it simply lets your friends know that you're 
on the phone.  This feature will not disconnect any ongoing chats that you 
may have going. 

We also ship an example AppleScript that mutes your iTunes music 
playing while you’re on the phone, and starts your songs playing again 
once you hang up. 
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Recording and Voice Mail AppleScripts 

Recording and Voice Mail scripts run after a call is over and a voice mail 
message was taken or a call recording was made.  Similarly to Caller ID 
scripts, all the caller information about the call is provided to the script 
function, as well as the location and name of the sound file. 

The example scripts shipped with PhoneValet will take each recording or 
voice mail message and add the audio file to your iTunes library, inside a 
play list (one for recordings and one for voice mails), which allows you to 
listen to them from iTunes, or to sync them onto an iPod or other music 
player.  Not all iPods and iPhone devices can play 3GPP files, so you 
should select the WAV or AAC file formats for iPod compatibility. 

Example Scripts 

More detail about how to write AppleScripts and additional example 
scripts are provided on the PhoneValet support website at 
http://www.parliant.com/support/phonevalet/. 

Example scripts shipped by Parliant are ready to run, and include 
complete source code, so you can examine how they work, make your 
own changes, and use them as the starting point for your own scripts.  
Look in the /Library/Application Support/Parliant/AppleScripts folder 
for the example files.  Open scripts with Apple’s Script Editor to view/edit 
the source code. 

Disc Archiving 

PhoneValet includes a feature to archive (“burn”) calls and audio 
(messages/recordings) to recordable CDs and/or DVDs.  Disc burning 
can be used to create a backup record of your calls and audio, or to make 
a disc for presentation to clients (for instance, as part of client billing or for 
delivery of phone interviews). 

PhoneValet creates an index on each disc that contains full call log 
information for each call on that disc. The index is written in HTML format 
and can be read using any web browser on Mac or Windows computers. 
The index includes clickable links to the audio files, which makes locating 
and playing audio a snap. (For a picture of this index, see the PhoneValet 
Anywhere pictures on page 33 which have a similar display format.) On 
Windows, QuickTime is required to listen to audio files from within the 
web browser (QuickTime is already included on all Macs.) 

You can burn selected calls to disc (by selecting calls with the 
mouse/keyboard), the results of a call report (see page 25 for report info), 
or the whole call log. If you burn a lot of calls (especially if you have long 
recordings), PhoneValet will automatically burn multiple discs as needed 
to fit all the calls; it will warn you in advance if multiple discs are required. 

You can also opt to move the audio files from your computer onto the 
disc.  If you move the audio (instead of making a copy), then PhoneValet 
will delete the audio files from your computer’s hard disk, but the call 
information will remain in the call log.  If you click on one of these calls in 
the call log, the details drawer will display a message indicating what disc 
(by name) the audio is stored on.  If you insert that disc, PhoneValet will 
find the audio and the playing controls will appear automatically. 

Disc burning can also be used to create discs for presentation to clients.  
To help make the discs, PhoneValet lets you add extra files of your own 
to the disc – such as reports or other documents you want to send.  In this 
way, you only need to make a single disc.  You can add as many files and 
folders to the disc as you want. 

Starting a Disc Burn 

To make a disc, click on the Call Log.  If you want to burn a specific set 
of calls, run a report (see page 25), or use the mouse/keyboard to 
highlight the calls you want.  To start a disc burn, click on the File -> Burn 
<XX> Calls to Disc sub-menu.  The menu item is customized to show 
you the number of calls that you have selected (or all calls if none are 
selected). 

http://www.phonevalet.com/support/
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Then, a disc options panel will appear.  On this panel, you can set the 
name of the disc, decide if you want to copy or move the audio (as 
discussed above), and add any extra files or folders to the disc as 
needed.  After setting your options as desired, click OK.  You will then be 
prompted with the standard Mac OS disc burning panel, which asks you 
to insert a writable disc.   You can show the burn options by clicking the 
downwards-facing triangle on the top-right.  Insert a blank (or re-writable) 
disc, and click Burn after setting your options.  Parliant strongly 
recommends enabling the Verify burned data option, which takes longer 
but ensures the disc was burned correctly. 

At this point, you will see a small panel with a progress meter that will 
show you the progress of the burn.  You can continue to work in the 
PhoneValet application at this point – but you will not be able to quit the 
application or delete calls/audio until the burn is done or cancelled.  If 
more than one disc is required to fit the calls, PhoneValet will prompt you 
and tell you how many discs are required. 

If multiple discs are required, you should use only discs of the same 
capacity as the first disc you inserted.  Note that recordable CDs come in 
different sizes – varying between 600MB and 700MB – make sure you 
use only discs that store at least as much as the first disc you insert.  
PhoneValet supports any disc burners and CD or DVD recordable disc 
formats that your Mac OS supports for the Finder’s disc burning feature. 

How to Use an Archived Disc 

To use an archived disc, simply insert it into any computer.  Open the file 
“index.html” with any web browser and you will be able to browse the calls 
that were burned to disc.  If you have the QuickTime player installed, you 
can click on the details for each call and use the QuickTime player in the 
browser to listen to the audio.  The web site put onto the disc is very 
similar to the web site produced by PhoneValet Anywhere, except that the 
search and sort features are not available.  See page Error! Bookmark 
not defined. for information about how to navigate the web site. 

The audio files on the disc are stored in their original format (3GPP, AAC, 
or WAV based on your PhoneValet preferences) and are stored in the 
CallLogAudio folder on the disc.  The files are sorted into folders based 
on the date, for easy access, in case you want to work with the audio files 
in a separate program.  If you burned extra files/folders of your own onto 
the disc, those files/folders will appear at the top level folder of the disc. 

Importing and Exporting 

PhoneValet provides advanced features to collect names and numbers 
you may have already entered into other address book programs on your 
computer, as well as to let you export names and call log information to 
use in other programs. 

Importing Names and Numbers into the Phonebook 

PhoneValet’s import feature allows you to add existing phone listings to 
the phonebook from Apple’s Address Book, or from comma- or tab-
delimited files.  This can save you from having to type names and 
numbers in by hand, if you’ve already done that in these other programs. 

Parliant has tested the file import to work with the programs below, 
although exports from many other programs may work.  Future updates of 
PhoneValet will enable imports from other programs.  Please visit our 
support website at http://www.phonevalet.com/support/ for updated 
information, and for help on ways to convert your files into a supported 
format. 

• Microsoft Entourage v.X 
• Palm Desktop (tested with versions 2.6 and 4.1) 
• Now Contact (tested with v4.2; use the “Default” export template) 
• Big Island YoYo phonebook 

To import from Apple’s Address Book, simply select from the menu the 
File -> Import to Phonebook -> from Address Book item.  To import 
from another program, go into that program and export the data that you 

http://www.phonevalet.com/support/


want to use into a comma- or tab-delimited file (this is the format most 
programs use).  Once you saved the file from the other program, simply 
select the File -> Import to Phonebook -> from File item. 

PhoneValet will search through your Address Book or file, and then take 
you to the import screen that looks like this: 

 

This screen shows you what will be imported.  The upper half of the 
screen shows you new names/numbers that you can import.  The lower 
section shows you names that already exist in your phonebook but which 
have a different phone number in the import data. 

You can choose not to import a number by simply un-checking the box in 
the left column.  If you only want to import a small set of numbers, then 
click the Uncheck All button, and then check only those records you 
want. 

You may edit any of the fields you see on-screen – just double-click on a 
name, number, etc… and start typing.  If you want to set the “Also Speak” 
(which is spoken to you when calls come in from that number), you can 
automatically fill that column with either the company name, job title, or 
both.  Click on the Also Speak Options pull-down and select what you 
would like to see.  NOTE: Make sure you select an also-speak option 
before manually editing the Sounds Like fields – using that pull-down later 
on will replace your typing in that column! 

When you're done adding entries, push the Import button, and you will be 
returned to the main screen, and your new numbers will be in the 
phonebook. 

Exporting from the Phonebook and Call Log 

You can export the names and numbers from the PhoneValet phonebook, 
as well as the records in the call log to a file.  Exporting the phonebook 
can help populate the address book of another program.  Exporting the 
call log can help you if you need to bill people for the time you spend on 
the phone. 

You can export the whole call log or phonebook, the results of a search, 
or just the rows that you have selected with the mouse. Click on the either 
the Call Log or Phonebook tab as appropriate so that the data you want 
to export is on the screen.  Then, Select File -> Export <X> Calls to File 
from the menu (the title changes to “Phonebook Numbers” if you’re in the 
phonebook).  If you want to export only some of the rows that are visible 
in the list, select them with the mouse by click-and-drag or using the 
command and option keys, and then click on the File menu – the title of 
the export menu item will change to reflect the selected number of rows. 
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On the panel that comes up (see above), pick the file type you want 
(comma- or tab-delimited), and which fields you wish to export (simply un-
check the ones you don’t want).  If you click on a field name, and then 
click the Move Up or Move Down buttons, then you can reorder the 
fields. 

When you’ve configured the export to your satisfaction, click the Export 
button. The standard save panel will come up.  PhoneValet presets the 
file name to have an extension of .tsv for tab-separated files, and .csv for 
comma-separated files.  We recommend you preserve the file extension 
even if you rename the file, so that other programs will have an easier 
time loading these files.  For instance, Microsoft Excel can automatically 
load our PhoneValet’s comma-separated files and place each field into its 
own column. 

PhoneValet Anywhere 

PhoneValet Anywhere is an optional extension to PhoneValet that permits 
web access to your call log and phonebook and can send Caller ID 
announcements to remote Mac and Windows computers.  PhoneValet 
Anywhere is an add-on product to PhoneValet requiring a separate 
license code.  Visit Parliant’s web site at http://www.parliant.com/ for 
details. 

This section of the manual covers using the features of PhoneValet 
Anywhere.  Installation and configuration of the web users and client 
software is covered on page 39. 

Network Caller ID Announcements 

PhoneValet Anywhere can send call announcements and pages (from 
page-and-pause voice mail choices) to Mac OS X and Windows clients, 
and to other client software that uses the “YAC” network protocol.  A web 
search for “yac caller id” will yield information about alternate clients for 
other kinds of computers. 

To configure the announcements on a Mac, run the configuration program 
called PhoneValet Announcements, which is stored in the /Applications 
folder.   This will configure the announcement program to run 
automatically each time you log into your Mac, and lets you change the 
size and allowed times for spoken call announcements, as on this screen: 

 

You can check to see if you have the latest client software by clicking on 
the Actions menu and selecting Check for Updates. After you click Save, 
the announcement program will run in the background (no icon will 
appear in the Dock) and display call announcements as calls come in.  
Make sure your client is set to receive announcements in the server’s 
configuration if there is any problem. 
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On Windows computers, the call announcement program provides Caller 
ID and page-and-pause display, but cannot speak announcements.  Upon 
installation, the announcement program is set to start at boot/login time.  
The call announcements look like this: 

 

You can click on the small red PhoneValet icon in the tool tray (bottom 
right) to view a list of recently announced calls, and to change the 
appearance of call announcements. 

Web Access 

PhoneValet Anywhere’s web access allows you to access PhoneValet’s 
data over a web browser.  Access comes in two formats – a desktop web 
interface provides access to calls with advanced search and extra 
features, and an iPhone interface that provides access to recent calls and 
messages using a simple and elegant interface optimized for the screen 
size and controls of the iPhone and iPod touch. 

PhoneValet Anywhere desktop mode provides access to view the 
phonebook and call log using any standard web browser, as well as 
watch the current status of your phone lines and start/stop call recording.  
Using the desktop web interface, you can search, report and sort in the 
call log with an interface similar to the desktop software, and listen to your 
call recordings and voice mail messages.  You can add notes to calls and 
phonebook entries. 

PhoneValet Anywhere iPhone mode provides a streamlined interface 
similar to the New Calls window in the PhoneValet application.  It allows 
you to view new/flagged calls, or the last 7 or 30 days of incoming calls.  
You can listen to messages and view the details of calls, flag calls, and 
write notes on calls.  The interface is optimized for the iPhone and iPod 
touch screen size and multi-touch interface. 

To start, you need to run your web browser and connect to the server.  
When using Safari on a Mac, or Internet Explorer (IE) on Windows, you 
can use the “Bonjour” features in the browser to connect with a single 
click.  If you use Safari, please enable Bonjour (called “Rendezvous” on 
Mac OS X 10.3 and earlier) on your Bookmarks bar or menu in the Safari 
preferences under "Bookmarks".  On Windows, enable the Bonjour 
feature in IE by clicking on the View menu, and enabling the Bonjour 
option in the Explorer Bar (requires Bonjour for Windows to be installed). 

You can access the server by choosing "PhoneValet Anywhere on 
<machine name>" from the Bonjour (or Rendezvous) menu. 

If you are not on the same local network as the server, or you use a 
different web browser than Safari or IE for Windows, you will need to type 
a web address into your web browser, as below. Replace 
phonevalet.ip.address or machinename.local with the IP address or name 
of the computer running PhoneValet.  You can find the name and/or IP 
address of the server computer in the System Preferences application 
under the Sharing section. 
 http://phonevalet.ip.address/cgi-bin/phonevalet.cgi/ 
 http://machinename.local/cgi-bin/phonevalet.cgi/ 
 
If you are less concerned about security, you can type your username 
and password in the web address.  You can write the URL in this form 
and bookmark the link to avoid having to log in: 

http://ip.address/cgi-bin/phonevalet.cgi/?username=youruser&password=yourpassword 

 

Desktop Browser Navigation 

Once you get to the web access screen as above, you will be prompted 
for your username and password.  Please enter the information given to 
you by the person who set up the server, or go to the server Mac 
computer and add a username if you don’t have one. 
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Once you are logged in, you will see a screen as below.  You can click on 
the tabs at the top to change to the Phonebook or Call Log, to run reports 
on the Call Log, or to display the Activity Monitor window. 
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As you can see on the screen, there are search and sorting tools 
available on the left side of the main window, to let you search, filter and 
change the column to sort by and the number of records you see per 
screen.  Quick Search lets you filter your list of calls to match a name or 
number you enter.  Limit Calls allows you to show only new, flagged or 
recent calls.  Adjust View allows you to control the sorting and number of 
rows per page. 

Under those options are “jump” links that let you jump forward or 
backward many screens at once – the links are based on your current 
sort column and show you around .  This is especially useful for large call 
logs where there could be many screens of calls to show.  Once you’ve 
moved forward and are close to calls that you’re looking for, you can use 

the Previous Page and Next Page links (top right and left) to move one 
page. 

To show the details window for a call, click on the magnifying glass 
in the Detail column.  If you click on the casette/microphone icon in 
the Msg column, the details window will display, and playback of the 
message will start right away.  If you change the notes in the detail 
window, click the Save Notes button to save your changes.  These 
notes will be made visible to the PhoneValet desktop application as 
well as all web users. 

New calls will be highlighed in yellow in the table.  If you listen to the 
message, the call will be marked as normal (if your preferences are 
set this way).  You can click the Mark as: links in the details 
window, to change the call between Normal, New or Flagged status. 

The Call Report tab gives you access to run reports.  The reports 
have exactly the same options as the report feature in the desktop 
application.  See page 25 for info on the reporting options and how 
they work.  When a report is being displayed in the call log, the 
quicksearch box (top left) is replaced with a Displaying Call Report 
section, so you know that you’re looking at only a partial call log.  

You can cancel the report by clicking Close or click Change to change 
the report criteria. 

The Activity Monitor is accessible by clicking on the Activity tab.  This 
opens a small window that shows you the current status of all your 
PhoneValet lines – you can see what calls are in progress, and start/stop 
call recording.  This window automatically refreshes its display every few 
seconds, and you can click the Refresh Display link to do that at any 
time.  If you opt to close the larger main PhoneValet Anywhere browser 
window, you can bring it back at any time by clicking the Re-Open main 
window link – your session is kept open by the smaller Activity window. 

If you leave your browser displaying a call log or phonebook view, the 
page will refresh automatically every few minutes, which will keep you 
signed in. 
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iPhone Browser Navigation 

When you access PhoneValet 
Anywhere using the iPhone’s web 
browser, you are given a special view of 
your calls suited to the screen and 
interface of the iPhone.  This view is 
designed to be similar to the iPhone’s 
built-in voicemail feature. 

This web access is also supported on 
the iPod touch, which features the same 
Safari web browser as the iPhone. 

In iPhone mode, you can review your 
recent calls – either all new/flagged 
calls, the last 7 days or last 30 days of 
incoming calls.  You can change what’s 
in the list by clicking on the pop-up 
menu at the top. 

You can scroll the list by holding two 
fingers down in the list of calls and dragging up and down.  To select a 
call, just tap on the name/number area.  When you do, the buttons at the 
bottom light up as appropriate and the call is highlighted in yellow.  You 
can click Listen to hear the message for the call, click Call Back to place 
a call to that caller’s number (not available on iPod touch), or click Details 
to go to the call details screen. 

If you click on the left side of a call’s row (to the left of the name/number), 
you can toggle the calls from normal (no image) to “new” ( ) or to flagged 
( ). 

 

 

If you click the Details button, you 
can view the details of a call, including 
the full time and date of the call.  You 
can change the call status from this 
screen by clicking the pop-up menu in 
the center. You can also view and edit 
notes for the call; you may need to 
scroll down by dragging one finger 
downwards on the screen to read all 
the notes if they are long.  If you tap 
edit notes (or add notes), the notes 
area becomes editable, and the on-
screen keyboard will appear for you to 
type notes.  After editing notes, click 
the Save Notes button below the 
notes area to save your changes to 
PhoneValet’s call log. 

The Listen button takes you to the 
iPhone media player so that you can 
listen to the voicemail message for 
the call.  After you’ve listened to the message, click the Back button 
(bottom-left of the screen, triangle pointing left) to return to the Details 
screen.  You use the same Back button to return to the list of calls as well. 

iPhone audio formats 

The iPhone does not support all the audio formats that PhoneValet can 
use.  PhoneValet Anywhere for iPhone will automatically convert audio 
files when downloaded to the iPhone’s media player into a compatible 
format.  The AAC format used has reasonable quality, and is small 
enough that it should download at reasonable speed on the EDGE 
network.  As the iPhone’s software is upgraded, more audio formats may 
be supported. 



Appendix A: Advanced Dial Settings 

Dialing Rules  

PhoneValet uses your Local and Long Distance preferences to help dial 
the phone.  In particular, you configure PhoneValet to understand that you 
may need to dial certain numbers before or after a phone number in order 
to complete the call.  In an office, you may have to dial 9 to get an outside 
line.  In many large cities, you may need to dial the area code as part of 
the number even when making a local call (this is often called 10-digit 
dialing). 

Note that there may be no need to change the default dialing settings, 
especially if you only have a single regular phone line.  If you go into the 
preferences (Click on the PhoneValet menu, and select Preferences → 
General…) you can configure your dialing setup. 

On the Local preferences tab, you can set your local area code (which is 
important!), and other area codes that may be in your local calling area.  If 
you live in an area where you need to do 10- or 11-digit dialing, then you 
should enter your other local area codes, and choose the right way to dial 
(7, 10 or 11 digits). 

Setting up Calling Cards and Long Distance Access Numbers 

On the Long Distance tab, you can configure how numbers should be 
dialed when they’re long distance.  Most of the time, PhoneValet will 
automatically detect a long-distance number and dial it using the Default 
dialing rule.  If you make long-distance calls using a calling card, or with a 
1-800 or “10 10” access number, you can configure a new rule for each 
way you want to dial.  You can set a number in the phonebook to be 
dialed with any dialing rule you set up – once you save your preferences, 
simply click on the pop-up below the number, and pick one of your dialing 
rules as in this picture below. 

 

To create a new dialing rule, click on the Rules pull-down in the Long 
Distance preferences and pick Add New…, then type in a name for your 
dialing rule.  If you’re using a service that requires you to dial an access 
number, type that into the First dial section.  If you also need to type a 
PIN or other code before the number, separate the access number and 
the PIN by some commas – each comma causes a 1 second delay before 
dialing the rest of the numbers.  For instance, you might have a “First 
Dial” of “1-888-222-3333,,,,,12345678” which would mean to dial 1-888-
222-3333, then pause 5 seconds, then dial the PIN 12345678, and then 
the software would dial the actual area code and number of the caller. 

If you have a traditional calling card, you might enter just “0” in the First 
dial field, and put “,,,,12345678” in the Last dial field.  This would cause 
the software to dial 0, the area code and the number, then pause 4 
seconds, and the dial your PIN 12345678. 

10-digit and 11-digit Dialing 

When configured for 10/11-digit dialing, PhoneValet will dial all 10/11 
digits for local calls in the specified area codes(s).  When entering 
domestic numbers, PhoneValet will automatically add your local area 
code.  Just make sure to enter all of your city’s area codes into the 
General Preferences’ Local tab. 

If you enter a number which is in your local area code, but which you 
know to be long distance, you can simply pick the Force to Long 
Distance dialing rule which is always available when editing the 
phonebook.  This will cause PhoneValet to dial the number with the 
default long-distance dialing rule.  You can also pick any of the dialing 
rules you have created if you want dialing using a calling card or access 
number. 
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Special Dialing Characters 

Comma (,) 

A comma in a phone number will cause a pause of 1 second when 
PhoneValet dials your call.  For example, the number (203) 227-9700,,21 
will dial 203-227-9700, wait 2 seconds, and then dial 21.  This is useful if 
you're dialing an automated service that wants you to enter numbers or 
codes, such as an automated attendant, phone banking system or other 
automated phone system which has a predictable delay between 
prompts. 

Star and Pound (* and #) 

You may embed the # and * characters in the numbers you enter, and 
they will be dialed correctly. 

Appendix B: Technical Details 

Verifying that the Telephone Adapter is Functioning 

The small light on the top of the Telephone Adapter can be used to verify 
proper operation. 

For first-generation Telephone Adapters (blue in color), the light should be 
on solid red when the computer is running and the software is working.  
The light will slowly flash whenever a phone is off the hook, and go back 
to solid-on when you hang up the call. 

For second-generation Telephone Adapters (grey in color), the light will 
be on solid green when the software is connected to the device and will 
flicker red when the device is communicating with the computer.  If the 
light is off, check the connections, and make sure that you are connected 
to a full-power USB port.  Try connecting the device directly to your Mac’s 
built-in USB ports if not already connected there. 

About USB Ports and Hubs 

The PhoneValet Telephone Adapter is a high-speed USB device.  As 
such, is must be connected to full-speed USB 1.1 or 2.0 ports, such as 
those which are built into your Macintosh. 

If you use a USB hub (which gives you extra ports), make sure to use one 
which provides full-speed USB 1.1 or 2.0 ports and has its own power 
supply that plugs into a wall socket.  You may have USB ports on your 
keyboard or screen - these are almost always low-power ports intended 
only for devices like keyboards or mice, and may not work with 
PhoneValet. 

Backup and Restore 

PhoneValet stores your calls, phonebook and settings in a database, as 
described below.  The PhoneValet application includes a backup and 
restore feature that lets you make a single-file backup of your data for 
safe-keeping.  This backup can also be used to copy your data from one 
Mac to another. 

PhoneValet makes automatic backups every 24 hours and stores these 
files in the /Library/Application Support/Parliant/Backups folder.  The 
software automatically keeps the last 5 backups in that location.  You can 
also manually make a backup at any time by clicking on File -> Backup 
PhoneValet in the menu.  If you back up your computer to disk, tape, 
DVD, or other media, make sure to include the above Backups folder in 
your backup profile, as well as your messages and greetings that are 
stored in /Library/Application Support/Parliant/Messages, and also 
any AppleScripts you may have written.  Your messages and greetings 
are not included in the database backup file. 

If you need to restore, simply copy back the Messages folder from your 
backup to the location as above, and then restore your database from the 
application by selecting File -> Revert to PhoneValet Backup.  This will 
erase your current data and replace it with the contents of the backup.  
More help with backups is available on Parliant’s support web site. 
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OpenBase Database 

PhoneValet includes the OpenBase 10 database, and uses that database 
to store the phonebook, call log, preferences and so on.  Users do not 
need to interact with the database to use PhoneValet – it is completely 
managed by PhoneValet.  OpenBase is a powerful SQL relational 
database. 

For developers and other advanced users, Parliant’s arrangement with 
OpenBase permits users to have read-only access to run SQL statements 
against our database.  Parliant does not provide technical support for 
database access.  If you are developing a vertical market product (such 
as a billing application that would use call log data) that would benefit 
from more access to our database, please contact Parliant for information 
at http://www.parliant.com/contact/. 

To connect to the database, use the username phonevalet and the 
password phonevalet.  The database is called ParliantCTI.  Connections 
are possible via OpenBase’s Manager software, the openisql command-
line tool, and via many different client libraries and query tools.  Visit 
http://www.openbase.com/ for more information about the capabilities of 
OpenBase. 

Technical Support 

If you need help with Parliant's PhoneValet, the place to start is our web 
site for all sorts of technical resources, including updated documentation, 
frequently asked questions and other information about USB and 
telephony issues.  If you don't find your answer on our web site, there is a 
form you can fill out to send a message to Parliant's Technical Support 
team.  Simply click on the Contact Us link that's on every page of the 
Parliant site. 

Web Site: http://www.phonevalet.com/support/ 

Software Updates 

PhoneValet has the built-in ability to find and download updates to the 
software over the Internet.  You can check for updates by selecting 
Check for Updates from the PhoneValet menu.  The software will see if 
there's a new version by contacting Parliant's Internet server.  If there is a 
new version, you will be asked if you want to download and install it.  
Simply say yes to the upgrade and it will be downloaded using your web 
browser. 

Updates and improvements will be made continuously, and are free of 
charge.  For major revisions, or for additions of whole new feature sets, 
there may be an upgrade charge. 

http://www.parliant.com/contact/
http://www.openbase.com/
http://www.parliant.com/support/


Appendix C: PhoneValet Anywhere Installation 

PhoneValet Anywhere is an add-on option to PhoneValet Message 
Center that requires a separately purchased license that provides 
unlimited users and Caller ID clients as part of a single server license.  
More detailed setup help for PhoneValet Anywhere is available from 
Parliant’s web site at http://www.parliant.com/support/phonevalet/ 

Web Server Installation 

Configuring PhoneValet Web Access is simple.  First, create usernames 
and passwords.  Select Anywhere Configuration… from the main menu 
and click on the Users tab.  Click the Add button and enter a username 
and password.  If you need to change a password, simple double-click in 
the Password column and type the new password. 

 

You also need to activate the Mac OS’ built-in Personal Web Sharing 
feature.  Run the System Preferences application, and click on the 
Sharing item.  Under the Services tab, check the Personal Web 
Sharing box on.  This panel also lets you view/set your computer’s name 
– look at the top, just under the Computer Name field.  The name below, 
ending in “.local” is a name you can use on Bonjour-enabled computers, 

in place of the IP address, to type in web addresses, for use with 
browsers other than Safari that don’t have Bonjour web support. 

If you want to access PhoneValet’s web features from outside your local 
network, including remote access using an iPhone or iPod touch, you may 
need to configure your firewall/router to allow this.  Tips for advanced 
setups are available on Parliant’s web site at: 

http://www.parliant.com/support/phonevalet/ 

Caller ID Client Configuration 

To configure the Caller ID clients on your network, start by installing and 
running the client software, and then go to the server and add the clients 
to the list. 

For Windows and Mac clients, the client software installer is available on 
the PhoneValet software CD, in the Extras folder.  Look under the 
Network Client folder for the installers.  You can copy the files to your 
Mac or Windows client computers.  The Mac installer is a DMG disk 
image – double click and run the installer.  The Windows installer is a 
single .exe file that will install the software when run.  If it is more 
convenient, you can download the latest client software from the Parliant 
support site at http://www.parliant.com/support/phonevalet/ 

For Windows 2000 and higher, Parliant also strongly recommends 
downloading and installing Bonjour for Windows from Apple before 
installing the Windows client. It will make configuring and using 
PhoneValet Anywhere easier.  This software is available from Apple at 
http://www.apple.com/macosx/features/bonjour/ 

Once one or more clients are installed and running, go to the server 
computer, run the PhoneValet application and pick Anywhere 
Configuration… from the main menu.  Click on the Computers tab and 
click Add, and you will get a panel as below.  Either select a computer 
from the list to add (which should list all Bonjour-compatible clients), or 
type in a hostname (like “macmini.local” or IP address like “192.168.1.1”) 
and click Add.  For Windows clients, you may also type the Windows 
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computer-name for the client, as set in the Windows network settings.  
After adding, make sure the Client Type is correct – either Mac or 
Windows/YAC. 

 

You can install the client software on remote computers – i.e. on those 
that are at another location.  In this case, they will not display in the list of 
computer, and you will need to enter a valid hostname or IP address.  At 
the client site, if a firewall is installed, it may prevent the call 
announcement messages from getting through.  You may need to open 
ports on the firewall to permit the call announcements to get through.  For 
Mac clients, you need to open TCP port 4681.  For Windows and other 
YAC protocol clients, you need to open TCP port 10629. 
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Appendix D: Certification and Warranty Information 

Hardware Certification Information 
FCC Part 15: Radiated & Conducted Emissions (USA) 

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the 
FCC Rules.  These limits are designed to provide reasonable protection against harmful interference in a residential 
installation.  This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications.  However, there is no 
guarantee that interference will not occur in a particular installation.  If this equipment does cause harmful interference to 
radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following measures: 

• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver.  
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

FCC Part 68 (USA) 

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA. On the bottom of this 
equipment is a label that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If 
requested, this number must be provided to the telephone company. 

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with the 
applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is 
provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See 
installation instructions for details. 

The REN is used to determine the number of devices that may be connected to a telephone line. Excessive RENs on a 
telephone line may result in the devices not ringing in response to an incoming call. In most but not all areas, the sum of 
RENs should not exceed five (5.0). To be certain of the number of devices that may be connected to a line, as determined 
by the total RENs, contact the local telephone company.  PRL-VDM-II-C has a REN of 0.1B 

If this equipment PRL-VDM-II-C causes harm to the telephone network, the telephone company will notify you in advance 
that temporary discontinuance of service may be required. But if advance notice isn't practical, the telephone company will 
notify the customer as soon as possible. Also, you will be advised of your right to file a complaint with the FCC if you 
believe it is necessary. 

The telephone company may make changes in its facilities, equipment, operations or procedures that could affect the 
operation of the equipment. If this happens the telephone company will provide advance notice in order for you to make 
necessary modifications to maintain uninterrupted service. 

If trouble is experienced with this equipment PRL-VDM-II-C, for repair or warranty information, please contact Parliant 
Corporation, by phone 613 321 9923 or web site at www.parliant.com.  If the equipment is causing harm to the telephone 
network, the telephone company may request that you disconnect the equipment until the problem is resolved. 

There are no user serviceable parts in the device. 

Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service 
commission or corporation commission for information. 

If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of this PRL-VDM-
II-C does not disable your alarm equipment. If you have questions about what will disable alarm equipment, consult your 
telephone company or a qualified installer. 

Industry Canada  ICES-003 (Class B) – Radiated & Conducted Emissions  

This Class B digital apparatus meets the requirements of the Canadian Interference-Causing Equipment Regulations ICES-
003. 

 WARRANTY INFORMATION   
The warranties described below are extended only to the original purchaser and are not transferable. 

LIMITED WARRANTY: Software 

PARLIANT warrants that the Software will perform substantially in accordance with its accompanying documentation for a 
period of one (1) year from the date of purchase. Product support is provided throughout the warranty period, and shall be 
conducted electronically through Parliant’s website at www.parliant.com/support. 

EXCEPT AS SET FORTH IN THE PRECEDING SENTENCE, PARLIANT AND ITS SUPPLIERS DISCLAIM ALL OTHER 
WARRANTIES OR CONDITIONS OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, CONTINUATION OF 
ANY SERVICE OR FUNCTION PROVIDED THROUGH THE INTERNET OR NON-INFRINGEMENT.  NEITHER 
PARLIANT NOR ITS SUPPLIERS WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET 
YOUR REQUIREMENTS OR THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE.  
YOU AGREE TO ASSUME FULL RESPONSIBILITY FOR THE SELECTION OF THE SOFTWARE TO ACHIEVE YOUR 
INTENDED RESULTS, AND FOR THE INSTALLATION, USE AND RESULTS OBTAINED FROM THE SOFTWARE.  YOU 
ALSO ASSUME THE ENTIRE RISK OF ANY USE OF THE SOFTWARE.  NO DISTRIBUTOR, DEALER OR ANY OTHER 
ENTITY OR PERSON IS AUTHORIZED TO EXPAND OR ALTER THIS WARRANTY. 

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY 
FROM COUNTRY/STATE TO COUNTRY/STATE.  SOME COUNTRIES/STATES DO NOT ALLOW THE EXCLUSION OF 
IMPLIED CONDITIONS AND WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. PARLIANT 
DISCLAIMS ALL CONDITIONS AND WARRANTIES OF ANY KIND IF THE SOFTWARE HAS BEEN CUSTOMIZED, 
REPACKAGED OR ALTERED IN ANY WAY BY YOU OR ANY OTHER PARTY.  

EXCLUSIVE REMEDY AND LIMITATION OF LIABILITY 

THE SOLE AND EXCLUSIVE REMEDY FOR ANY BREACH OF THE LIMITED WARRANTY SET FORTH ABOVE WILL 
BE, AT PARLIANT'S OPTION, (a) RETURN OF THE PURCHASE PRICE OR (b) REPLACEMENT OF THE DEFECTIVE 
SOFTWARE.   IN NO EVENT WILL PARLIANT OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, INCIDENTAL, 
SPECIAL OR CONSEQUENTIAL DAMAGES OR FOR ANY LOST PROFITS, LOST SAVINGS, LOST REVENUES OR 
LOST DATA ARISING FROM OR RELATING TO THE SOFTWARE, ITS USE OR INABILITY OF USE.  IN NO EVENT 
WILL PARLIANT 'S OR ANY OF ITS SUPPLIERS' LIABILITY OR DAMAGES TO YOU OR ANY OTHER PARTY EVER 
EXCEED THE AMOUNT PAID BY YOU TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF THE CLAIM 
(WHETHER IN CONTRACT, TORT OR OTHERWISE).  SOME COUNTRIES/STATES DO NOT ALLOW THE LIMITATION 
OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION 
MAY NOT APPLY TO YOU. 

LIMITED WARRANTY: Hardware 

1. Customer Obligations: 

A. CUSTOMER assumes full responsibility that the product purchased and any copies of software included with it or 
licensed separately, meet the specifications, capacity, and other requirements of the customer. 

B. CUSTOMER assumes full responsibility for the installation and effectiveness of the operating environment in which the 
product and software are to function. 

2. Limited Warranties And Conditions Of Sale: 

A. Manufacturer warrants that this product is free from all defects in materials and workmanship for one (1) year from the 
date of purchase from an authorized dealer. 

B. Except as provided herein no employee, agent, franchise, dealer or other person is authorized to give any warranties of 
any nature on behalf of manufacturer. 

3. Repairs And Service: 

A. In the event of malfunction or failure attributable directly to faulty workmanship and/or materials, the product should be 
taken to the original authorized dealer it was purchased from or sent to manufacturer, along with proof of purchase and the 
return merchandise authorization number (RMA) provided by manufacturer. 

B. If the product is sent by mail or freight company, the purchaser agrees to pay shipping charges, insure the product or 
assume the risk of loss or damage which may occur in transit, and to use a shipping container equivalent to the original 
packaging. 

C. Once a product is returned, manufacturer will at its option, repair or replace the defective product or components, to 
whatever extent it deems necessary to restore the product or component to proper operating condition. 

D. Manufacturer shall not be liable for any damages caused by delay in delivering or furnishing equipment and/or software. 

4. Limitation Of Liability: 

A. THE CUSTOMER SHALL BE SOLELY RESPONSIBLE FOR THE FAILURE OF THIS PRODUCT OR COMPONENT 
THEREON, RESULTING FROM ACCIDENT, ABUSE, OR MISAPPLICATION OF THE PRODUCT, AND 
MANUFACTURER ASSUMES NO LIABILITY AS A CONSEQUENCE OF SUCH EVENTS UNDER THE TERMS OF THIS 
WARRANTY. 

B. WHILE MANUFACTURER HAS MADE EVERY EFFORT TO PROVIDE CLEAR AND ACCURATE TECHNICAL 
INFORMATION ABOUT THE APPLICATION OF ITS PRODUCTS, MANUFACTURER ASSUMES NO LIABILITY FOR 
ANY EVENTS ARISING OUT OF THE USE OF THE TECHNICAL INFORMATION. 

C. ANY AND ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR USE, SHALL 
HAVE NO GREATER DURATION THAN THE PERIOD FOR THE EXPRESSED WRITTEN WARRANTY APPLICABLE TO 
THIS PRODUCT AS SHOWN ABOVE, AND SHALL TERMINATE AUTOMATICALLY AT THE EXPIRATION OF SUCH 
PERIOD. 
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H. THIS WARRANTY APPLIES ONLY TO THIS PRODUCT, AND IS GOVERNED BY THE LAWS OF THE PROVINCE OF 
ONTARIO, CANADA.  LAWSUITS BASED ON ANY CLAIM ARISING FROM USAGE OF THIS PRODUCT MUST BE 
FILED AND PERSECUTED IN A COURT OF COMPETENT JURISDICTION LOCATED IN THE CITY OF OTTAWA, 
PROVINCE OF ONTARIO, CANADA. 

D. NO ACTION SHALL BE BROUGHT FOR BREACH OF ANY IMPLIED OR EXPRESSED WARRANTY AFTER 30 DAYS 
SUBSEQUENT TO THE EXPIRATION OF THE PERIOD OF THE EXPRESSED WRITTEN WARRANTY. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer 
in the documentation and/or other materials provided with the distribution. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

G. SOME STATES/PROVINCES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON 
HOW LONG AN IMPLIED WARRANTY MAY LAST, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.  THIS 
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.  YOU MAY HAVE OTHER RIGHTS WHICH MAY VARY FROM 
STATE/PROVINCE TO STATE/PROVINCE. 

Neither the name of bDistributed.com, Inc. nor the names of its contributors may be used to endorse or promote products 
derived from this software without specific prior written permission. 

E. INCIDENTAL AND CONSEQUENTIAL DAMAGES CAUSED BY MALFUNCTION, DEFECT OR OTHERWISE AND 
WITH RESPECT TO BREACH OF ANY EXPRESSED OR IMPLIED WARRANTY ARE NOT THE RESPONSIBILITY OF 
MANUFACTURER, AND TO THE EXTENT PERMITTED BY LAW ARE HEREBY EXCLUDED BOTH FOR PROPERTY 
AND TO THE EXTENT NOT UNCONSCIONABLE, FOR PERSONAL INJURY DAMAGE. 

The PhoneValet software includes the BDControl framework which comes with the following statement which covers the 
BDControl portions of the PhoneValet software: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following 
conditions are met: 

F. IN ANY EVENT, MANUFACTURER LIABILITY SHALL NOT EXCEED THE PRICE OF THE PRODUCT. 

 

The specifications contained in this document are subject to change without notice. 

Document Revision: PV-541-20080617 

Ottawa, ON, Canada 

Parliant Corporation 

www.parliant.com 

6 Tangmere Ct. 
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Copyright © 2002, bDistributed.com, Inc. All rights reserved. 
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